CLEAR’ @

WIMAX/Wi-Fi
Mobile Internet Tablet

Getting Started Guide

SAMSUNG







Samsung Mondi™

WiMAX/IWi-Fi
Mobile Internet Tablet

Getting Started Guide
Please read this guide before operating your
device, and keep it for future reference.

AL

Mondi



Intellectual Property

All Intellectual Property, as defined below, owned by or which is otherwise the property of Samsung or its respective suppliers relating to
the SAMSUNG Device, including but not limited to, accessories, parts, or software relating there to (the “Device System”), is proprietary to
Samsung and protected under federal laws, state laws, and international treaty provisions. Intellectual Property includes, but is not limited
to, inventions (patentable or unpatentable), patents, trade secrets, copyrights, software, computer programs, and related documentation
and other works of authorship. You may not infringe or otherwise violate the rights secured by the Intellectual Property. Moreover, you
agree that you will not (and will not attempt to) modify, prepare derivative works of, reverse engineer, decompile, disassemble, or
otherwise attempt to create source code from the software. No title to or ownership in the Intellectual Property is transferred to you. All
applicable rights of the Intellectual Property shall remain with SAMSUNG and its suppliers.

Samsung Telecommunications America (STA), LLC

Headquarters: Customer Care Center:
1301 E. Lookout Drive 1000 Klein Rd.
Richardson, TX 75082 Plano, TX 75074

Toll Free Tel: 1.888.987.HELP (4357)

Internet Address: http://www.samsungusa.com

©2009 Samsung Telecommunications America, LLC is a registered trademark of Samsung Electronics America, Inc. and its related
entities.

Do you have questions about your Samsung Device?
For 24 hour information and assistance, we offer a new FAQ/ARS System (Automated Response System) at:

www.samsungtelecom.com/support

SWD-M100_GSG_CF03_PS_072109_F14


http://www.samsungusa.com
http://www.samsungtelecom.com/support

GH68-23169A

Printed in Korea

The Bluetooth® word mark, figure mark (stylized “B Design”), and combination mark (Bluetooth word mark and “B Design”) are registered
trademarks and are wholly owned by the Bluetooth SIG.

microSD™ and the microSD logo are Trademarks of the SD Card Association.

Open Source Software
Some software components of this product incorporate source code covered under GNU General Public License (GPL), GNU Lesser General
Public License (LGPL), OpenSSL License, BSD License and other open source licenses. To obtain the source code covered under the open
source licenses, please visit:
http://www.samsungnetwork.com/Home/opensource.

Disclaimer of Warranties; Exclusion of Liability

EXCEPT AS SET FORTH IN THE EXPRESS WARRANTY CONTAINED ON THE WARRANTY PAGE ENCLOSED WITH THE PRODUCT, THE
PURCHASER TAKES THE PRODUCT "AS IS", AND SAMSUNG MAKES NO EXPRESS OR IMPLIED WARRANTY OF ANY KIND WHATSOEVER
WITH RESPECT TO THE PRODUCT, INCLUDING BUT NOT LIMITED TO THE MERCHANTABILITY OF THE PRODUCT OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE OR USE; THE DESIGN, CONDITION OR QUALITY OF THE PRODUCT; THE PERFORMANCE OF THE PRODUCT; THE
WORKMANSHIP OF THE PRODUCT OR THE COMPONENTS CONTAINED THEREIN; OR COMPLIANCE OF THE PRODUCT WITH THE
REQUIREMENTS OF ANY LAW, RULE, SPECIFICATION OR CONTRACT PERTAINING THERETO. NOTHING CONTAINED IN THE INSTRUCTION
MANUAL SHALL BE CONSTRUED TO CREATE AN EXPRESS OR IMPLIED WARRANTY OF ANY KIND WHATSOEVER WITH RESPECT TO THE
PRODUCT. IN ADDITION, SAMSUNG SHALL NOT BE LIABLE FOR ANY DAMAGES OF ANY KIND RESULTING FROM THE PURCHASE OR USE OF
THE PRODUCT OR ARISING FROM THE BREACH OF THE EXPRESS WARRANTY, INCLUDING INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, OR LOSS OF ANTICIPATED PROFITS OR BENEFITS.



http://www.samsungnetwork.com/Home/opensource

Table of Contents

Section 1: Introduction 3 Section 3: Communication and Connection .

Accessing the Online User Guide ....................... 3 Communication Setup ...............
Poweringthe Device . ... 3 Airplane Mode ...
Initial Device Setup . ............. i 4 Activating Wi-Fi Communication . ......................
Charger and Battery Replacement ...................... 5 Connecting to a Mobile WiMAX Network . ................
Using the Kickstand .............. .. ... i 8 Bluetooth Communication ...........................
microSD Card Overview .................coooviinnn.. 8 Section 4: Synchronization
Rebooting the Device AfteraLockup ................... 10 Computer Requirements .................c.ovevvnn..
Section 2: Basics 1 Installation of ActiveSync on Your Computer ..............
Features of Your Device .............coviiiiiiiiann. 11 Connection of ActiveSync .. ...
YourDevice ... 12 Configuring ActiveSync ........... ... .. ...
Navigating the Today Screen ......................... 16 Setting Up Windows Media Player Sync Options ...........
Title Bar lcon Qverview . ............coiiineeeeeennn. 19 Synchronizing Music with Windows Media Player ..........
Locking Your Device . .........ovviiiiiiii i 20 Connecting to the Device via ActiveSync ................
Calibrating your Touchscreen ......................... 22 Loading Files to Your microSD Card ....................
Menu Navigation .. ... 22 Section 5: Email Setup
Adjusting Your Volume Levels ......................... 25 Setting Up an IMAP or POP3 Account ...................
Formatting the Device’s Memory ...................... 26 Editing an Email Account ................ ... i
Formatting the microSD Card ......................... 27 Using ActiveSync to Configure Your Outlook
Entering Text Using the QWERTY Keyboard ............... 27 Exchange Settings ........... ... 64
Entering Text using the Onscreen Keyboard .............. 31 Checking Your Outlook Email from the Today Screen . ... ... 66
Adjusting Text Input Settings ......................... 31
Widgets . ... 32
Widget Bar Navigation ................ ... ... 32



Section 8: Health and Safety Information

Section 6: Calendar and Contacts ..........ccccorererererannnns 68

Calendar

Contacts

Utilizing the CommunicationBar ...................... 74
Section 7: Applications 75

Microsoft Mobile Applications - Internet Explorer .......... 75

Microsoft Mobile Applications - Office Mobile .............
Windows Media Player ..............ccoiiiiinin..
Instant Messenger ...
Caleulator . ........ .
ClOCKS ..o
Using TaskSwitcher to Close Applications ...............
ROUTE 66 Navigation .....................

Health and Safety Information ........................
Samsung Mobile Products and Recycling . ...............
UL Certified Travel Adapter . ...............ooovveinn.
Consumer Information on Wireless Devices ..............
Road Safety ........... ..o i
Responsible Listening . ................ ... . ...
Operating Environment . ............. .. ...l

Using Your Device Near Other Electronic Devices ... ...... 104
Potentially Explosive Environments .. .................. 106
FCC Notice and Cautions .................coovvinnn. 106
Other Important Safety Information ................... 107

Product Performance .......... ... ..o, 107

Availability of Various Features/Ring Tones ............. 108
WIMAXLanguage ...........ooviiiiiinnnnnnnnnnn. 108
Battery Standby and Talk Time ...................... 108
Battery Precautions ............... .. o i 108
Window Mounted Accessory Precautions . .............. 110
Care and Maintenance . ................coiiiiinnn 110
Section 9: Warranty Information ..........cocoeeercrerererens 112
Standard Limited Warranty ......................... 112
End User License Agreement for Software .............. 115
Index 120




Section 1: Introduction

The Mondi™ (WiMAX Wireless Internet Tablet) now lets you
enhance your on-the-go experience. You can now take your
computer with you and enjoy all of its functionality on a tablet
powered by Microsoft’s Windows Mobile™ 6.1 technology.

Mondi™ offers a 4.3-inch diagonal screen which easily displays
your favorite documents, data, Web sites, and expands your
online experiences with applications such as Microsoft 0ffice®
Suite, Route 66, Widget application shortcuts,
Camera/Camcorder, and Windows Media Player®. All this access
is accomplished far easier with the availability of a full QWERTY
keyboard.

Accessing the Online User Guide
1. Launch your Internet browser.
2. Enter the following address into the Address field.
* www.samsung.com/us/mondi/userguide
Powering the Device

Starting up on your new device is quick and easy. This section
walks you through the procedures to turn on your device, use the
charger, install an optional microSD card, and reset the device.

Powering On your Device

» Press and hold (@@, until it vibrates and then shows the
powering up animation.

Powering Off your Device

» Press and hold (@) until you see and hear the powering
down sequence (Samsung information with sound) on the
display screen.

Power Button



Initial Device Setup 3. Use your stylus to calibrate the touch accuracy of the

If your device has never been powered on before and is screen by both accurately and firmly touching the center of
initializing for the first time, you will need to follow these each onscreen crosshair. Repeat this process for every
procedures. These same steps are necessary if the device is ever crosshair that appears until this step has successfully

Hard Reset (to factory default parameters).
1. Touch the main Windows Mobile 6.1 screen to begin the
initialization process.

completed.

align screen

2. Remove the Stylus from the side compartment (adjacent to
the Left Action key) (seen below).

Tap the target firmly and accurately
at each location on the screen. The
target will continue to move unk

Left Action key screen is aligned.

Note: This process may need to be repeated to accurately calibrate the
device. Once successfully calibrated, you are directed onto the Time
and Date screen.

Introduction 4



4. Use the drop down lists to adjust the fields within the date

and time page. Options include Time zone, Date, and Time.

o The Date field launches an onscreen calendar. Touch a date from
the calendar to make your update.

 The Time field requires that you first touch an onscreen number,
then use your QWERTY keyboard to update the time value.

5. Touch Next to complete the Data and Time updates.

Warning!: If your handset has a touch screen display, please note that a
touch screen responds best to a light touch from the pad of your
finger or a non-metallic stylus. Using excessive force, or a metallic
object when pressing on the touch screen, may damage the
tempered glass surface and void the warranty. For more
information, refer to “Warranty Information” on page 112.

Charger and Battery Replacement

Note: Use only Samsung-approved batteries and chargers with your device.
Failure to use a Samsung-approved battery and charger may increase
the risk that your device will overheat, catch fire, or explode, resulting
in serious bodily injury, death, or property damage.

Note: Long backlight settings, searching for service, vibrate mode, browser
use, and other variables can reduce the battery’s usage times.

Charging the Battery

Charge the device’s battery as soon as possible so you can begin
using your device. Even though the battery has been charged
prior to packaging, it is important to keep track of your battery’s
charge.

If the battery level becomes too low, your device automatically
turns off, and you will lose any current information. For a quick
check of your battery level, glance at the battery charge indicator
located in the upper-right corner of your device’s display screen.
If the battery charge is getting too low, the battery icon ()
blinks and the device sounds a warning tone.

Using the Travel Adapter

Your device is powered by a rechargeable Li-ion battery. The
included Travel Adapter charges your device’s internal battery.
Use only Samsung-approved batteries and chargers.

1. Locate the Power/USB Data jack (page 7).

2. Flip open the protective cover and plug the flat end of the
charger into the device’s Power/USB Data jack located on
the side of the device.

3. Plug the other end into a compatible electrical outlet.



Correct Incorrect
Installing the Battery
Warning!: Do not handle a damaged or leaking Li-lon battery as this action 2. Insert the battery into the opening (3), making sure to line
can result in being burned. o
up the gold contacts on the inside of the battery to those
1. Inasingle motion, press down on the cover, slide it away on the device. Gently press down to secure the battery (4).

from the lens (1), and then carefully lift the battery cover
(2) away from the device.
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3. Replace the cover by lining up the tabs and then firmly

sliding the cover away from the lens until it snaps into
place.

Replacing the Battery

If there is a need to replace the pre-installed battery, follow these
instructions.

Warning!: Do not handle a damaged or leaking Li-lon battery as this action
can result in being burned.

1. Make sure the device is powered off. For more
information, refer to “Powering Off your Device” on
page 3.

2. In asingle motion, press down on the cover and slide it
away from the lens and then carefully lift the battery cover
away from the device.

3. Slide your finger into the removal grooves (1) and carefully
remove the previous battery from the battery compartment

@.



MOBLE
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Using the Kickstand

The Mondi comes with a kickstand that is built into the rear
battery cover and can be pulled out to support the device when
rested upon a flat surface.

1. Turn the unit over to reveal the back battery cover.

2. Insert your finger into the groove at the end of the stand microSD Card Overview
and carefully pull outwards. When fully extended, the Although your device comes with 4GB of built-in memory, you
stand rests at a 45-degree angle from the battery cover. can supplement this storage capacity by adding an optional

microSD™ (Secure Digital) memory card. This added card is
used to provide a larger capacity storage medium to your device.
It allows you to store data, documents, images, videos, and
music onto your microSD card vs within device’s internal
memory.

3. Lay the device on a flat surface.

Note: Be careful not to extend the kickstand past the 45-degree angle as this
will damage the stand.
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Note: The device has been tested to support cards of up to 32GB. This
microSD card is an optional accessory, a card greater than 2GB is
recommended.

Warning!: DO NOT remove a microSD card while files are being accessed or
transferred, as this can result in loss or damage of data.

Caution!: Make sure your battery is fully charged before accessing/using the
microSD card. Accessed data may become damaged or unusable if
the battery runs out while using the microSD card.

Caution!: Ejection of the card is spring-loaded. As the microSD card is being
discharged from the slot, be prepared to catch it and keep it from
falling onto the floor.

Installation of the microSD Card
1. Locate the microSD card slot.
2. Flip open the microSD card slot cover.
3. With the gold contact pins facing downward, carefully
insert the card into the opening and firmly push it in until
you hear a click (indicating the card is securely installed).

Incorrect Correct

4. Once you are notified, touch Hide (from the bottom left of
the screen) to acknowledge the card is properly inserted
and ready to use.

Important!: It is recommended you only use an optional microSD card of at
least 2GB (up to 16GB). Using non-recommended microSD cards
could cause data loss and damage your device.




Removal of the microSD Card
1. Locate the microSD card slot on the underside of the
device and flip open the microSD card slot cover.
2. Firmly press the card into the slot and release it. The card
should pop partially out of the slot.

Note: You may need to use the tip of the included Stylus to push the card into
the slot.

3. Remove the card from the slot.
4. Place the microSD card cover back over the slot.
Rebooting the Device After a Lockup

The Reset button allows you to quickly turn off the device in the
event of a program or application error. In this case your Mondi™
would appear to “freeze” and become unresponsive.

1. Turn the device over and locate the Reset button positioned
adjacent to the Power button (seen below).

Reset Slot

2. Firmly insert the soft plastic tip of the included Stylus into
this slot or until the device exits the current screen and
cycles power to the device (turns off then back on)

(page 4).

Note: This reset action retains all of your device’s default parameters and
settings. This action is similar to that of a soft reset function on your
computer which only restarts the machine while maintaining all
current data intact.
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Section 2: Basics

Your Mondi™ Internet Tablet is packed with features that
simplify your life and expand your ability to keep you both
connected to your office and stay in touch with the people that
are important to you. This section will guide you through the
basic functions features of your device.
Your device provides many of the features associated with a
personal computer with exceptional portability, mobile
applications, and integration of a portable device. The device is
powered by Windows Mobile 6.1%, providing the power and
familiarity of Microsoft Windows.

Features of Your Device

Your tablet is an easy-to-use and offers many significant

features. The following list outlines a few of the features included

in your device.

 Touchscreen provides quick response to a variety of menus and
options

o Windows Mobile 6.1 Classic

o Windows ActiveSync® synchronization software

o Large 4.3 inch (800 x 480 pixel) screen displaying up to 16M (million)
onscreen colors

4GB of internal memory

1

* 3MP (megapixel) digital camera

o Full slide out QWERTY keyboard

 Customizable Widget application shortcuts

* Downloadable applications (via online purchase)

o Built-in Bluetooth technology

* Mobile WiMAX high-speed Internet access capable

o Built-in Wi-Fi support

 Full HTML Browser

* GPS Navigation (via embedded GPS chip)

 User friendly, menu driven access to features and options

o Microsoft Office Mobile® Suite applications (Excel Mobile, OneNote
Mobile, PowerPoint Mobile, and Word Mobile)

 Qutlook email client

o Internet email support (Google™ Mail, Yahoo® Mail, efc.)

 Support for playback of both streaming audio and video via sites, as
well as local media (within microSD card).

o Video Output (via optional mini-USB to HDMI cable)



Your Device

1.

OO ® OO

Display shows the information needed to operate your
device, such as the signal strength, battery level, time,
active application, etc.

@@ @

Webcam lens is used to shoot a streaming video of the user
during a video conference.

Light sensor uses the ambient light level to adjust both
screen brightness/contrast.

e |n a bright light condition (outdoors), the sensor causes the device
to increase the brightness and contrast for better viewing.

e |n a dark light condition, the sensor adjusts the device's brightness
and contrast for better viewing.

LED displays the current charging and network status.

e Green LED (solid) indicates the battery has been completely
charged.

¢ Red LED (solid) indicates the battery is charging.

e Green LED (blinking) indicates the device is attempting to connect
to a Mobile WiMAX network.

o Yellow LED (blinking) indicates a charging error.

o Cyan LED (blinking) indicates the device is attempting a connection
to a Wi-Fi network.

¢ Magenta LED (blinking) indicates an error message or an
outstanding notification the user has not yet read (accompanied by

on onscreen n ).
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Left Action key (n) is used to launch either the
MobileWidget screen or the TaskSwitcher application.

o Single press (quick) toggles between the Mobile\Widget screen
where you can use available Widgets (page 32) and the Today
screen.

 Press and hold to activate the TaskSwitcher application that allows
to display which applications are currently running on the device
and then choose which is displayed full screen and active.

Internet Explorer key short press to launch Internet Explorer
and long press to launch the Opera mobile browser.

Left Softkey (=) is used to navigate through menus and
applications by selecting the choice indicated on the lower
left area of the display screen. Softkeys are touch-
sensitive keys, that appear in your display, and change
function according to the current feature being used.

Navigation touch pad lets you access the device’s menus
and selects the highlighted choice when navigating

through a menu. Pressing the center button activates an
onscreen function (similar to pressing Enter) and selects
the highlighted choice when navigating through a menu.

10.

11.
12,

Fn key (Function) key, toggle to access the numbers/
symbols shown at the top left of selected keys on the
QWERTY keyboard. This feature is activated by pressing
and holding the Fn key in conjunction with other specified
keys.

Windows key provides ready-access to the Start menu that
contains links to all the device’s applications, settings, and
other quick links.

Symbol key provides access to symbol characters.

Space key lets you add spaces between words and
characters.

Note: Pressing both the Space and Fn key activates the TV out function, that

can only be used with the mini-USB to HDMI cable.

13.

14.

Messaging Key a short press provides access to the
Messaging menu.

o Press briefly to access the Messaging page (to access both Outiook
and Internet mail).

 Press and hold to launch the Notes application (to create new
notes).

OK key lets you end programs or then hide them.



15.

16.

17.

18.

19.

Page Up/Dn allows you to navigate up and down through
the currently active page, and also to navigate through the
different menu options.

Right Softkey (=) is used to navigate through menus
and applications by selecting the choice indicated on the
lower right area of the display screen. Softkeys are touch-
sensitive keys, that appear in your display, and change
function according to the current feature being used.

Right Action key ( n) is used to either return to the Today
screen (without exiting the current application) or
Lock/Unlock the device (simple lock without password).

o Single press (quick) returns you to the previous screen.

o Pressing this key ends/closes certain applications, such as Camera,
Opera, Smart Reader, and Sudoku.

e Press and hold to activate the screen lock/unlock functionality that
prevents accidental feature activation via inadvertent screen
touches. For more information, refer to “Locking Your Device”
on page 20.

QWERTY keyboard provides an alphanumeric character
keyboard layout. For more information, refer to “Entering
Text Using the QWERTY Keyboard” on page 27.

Speakers left and right stereo speakers.

20.

21,

22,

Camera Button lets you access the Camera mode you can
either take pictures or shoot videos (Camcorder mode).

e Single press to access the Photo Slides feature.

* Press and hold to access the Camera mode.

Reset Button lets you reset your device and ends all
applications currently running.

Power Button, located at the top rim of the device, lets
you either turn the device on/off (press hold) or help
conserve power by toggling the on/off state of the display
screen (single press).

e This single press conserves power by temporarily tumning off the
screen without shutting down the device. To turn the LCD back on,
simply slide out the QWERTY keyboard.

Note: Adjusting the screen brightness and temporarily shutting off the screen

can greatly increase battery usage times.

23.

Power/USB Data jack lets you connect a travel adapter
(power), USB data cable (data transfer), or HDMI cable
(video out). CAUTION! Inserting an accessory into the
incorrect jack may damage the device.
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24. Headset jack allows you to plug in a stereo headset (sold
separately).

25.

26.

27.

28.

29,

Stylus storage location of included stylus touch pen. It is
recommended that you use this pen when making your
onscreen selections. Using your fingers can be less
accurate, possibly scratch the screen, and leave
unnecessary residue.

Microphone allows the device to record external audio
sources.

microSD Slot lets you use a microSD card to expand the
memory of your device. For more information, refer to
“microSD Card Overview” on page 8.

Volume key allows you to adjust the device’s master
volume level that can also be done by activating the
Volume slider from the Title Bar (page 17).

Kickstand pulls out and provides support for the Mondi
when resting on a flat horizontal surface.



30. Camera/Mirror provides a 3.0 MP camera, with included
mirror, that lets you take pictures and shoot videos.

MOBILE
WwnmAx

SAMSUNG

Navigating the Today Screen

Mondi™ is powered by Windows Mobile 6.1® Classic, providing
the power and familiarity of Microsoft Windows. Mobile versions
of popular Microsoft applications such as Word, Excel®,
Windows Media Player® and Outlook® eliminating the need to
learn new software.

The main screen is called the Today screen. The items listed on
this screen provide quick access to several user selectable
applications (via Start menu or Shortcuts), Contacts, options, and
settings. The Today screen displays important information, such
as upcoming appointments, status indicators, the current date,
and time.

You can also launch a program directly by first activating the
Start menu drop-down list and then selecting the related tab and
the program’s associated icon.

» Single press the (n) (right action key) to launch the Today

Screen (Home).
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2. Start Menu located at the top left of the screen, opens a
drop down menu that serves as the central launching point
for Quick application links, access to device programs,
settings and Help topics.

% | Start

L I  The top row displays the six mostly recently used applications. As
further applications are launched, this row updates accordingly.

Recently Used Applications

®
@
®
®
)

WiMAX CM Main menu

® 0O ® ©

Today Screen Functions
1. Title Bar located at the top of the screen, displays the
currently active program, wireless status, and allows you
to close currently active screens. Click on the status icons 3. Position Bar located alongside the shortcuts, indicates the
to access abbreviated Connectivity, Volume, and Battery currently active menu.
settings menus.

:
5
3

FE
B
B
A
-
=
o

Main menu




Home Shortcut (ﬁ) displays the Today screen that
contains quick links to IM, Outlook email, Date/Time
information, Internet Phone, and any Upcoming
Appointments.

Web Pages Shortcut () displays either a Thumbnail or
Perspective view of currently stored Favorite Web
Bookmarks or Browsing History.

 Touch Menu (right softkey) > Display as > Thumbnail View to
display the Bookmark (History) page images in a grid view (2 rows
by 4 columns).

 Touch Menu (right softkey) > Display as > Perspective View to
display the Bookmarks (History) as a scrollable set of icons (one
behind another).

 Touch Menu (right softkey) > View >Favorite Bookmark to display
your favorite bookmarks. (These can be displayed in either a
Thumbnail or Perspective view.)

 Touch Menu (right softkey) > View > History to display the
browsing history. (These can be displayed in either a Thumbnail or
Perspective view.)

e Touch Edit Favorite Bookmark (left softkey) to edit your favorite
bookmarks.

o0

6. Applications (Main menu) Shortcut (OO) displays a grid

view of 12 preferred Main menu application shortcuts
(Favorites). These entries can be modified by Edit(ing)
which shortcuts appear onscreen.

Note: This listing of applications are different than those Programs provided

by the Windows Mobile 6.1% operating system (Start > Programs).

7. Favorite Contacts Shortcut ( 8 ) displays a scrollable list

of currently available Favorite Contacts. Scroll though the
entries and tap an icon/card (image) to access the
information for that particular Contacts entry. For more
information, refer to “Contacts” on page 71.

Multimedia Shortcut () displays a grid list of currently
available My Photos and Videos (Camera Album) and also
other available videos (Video Thumbnails) stored within the
the device or within the internal microSD card.

Quick Access displays onscreen icons (on the Today page)
that provide current information regarding your Instant
Messages, Outlook emails, Time/Date, Internet Phone, and
Appointments.
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10.

1.

12.

o Instant Messenger displays any unread chat messages.

o Qutlook Email displays the number of unread email messages.
o Clock displays the current date and time information.

o Internet Phone displays any missed Internet Phone calls.

o Appointments displays the number of upcoming Calendar

appointments or events. Touch this field to open the Calendar page.

WiMAX CM (left softkey) activates the Mobile WiMAX
Connection Manager page where you can easily establish
a connection between your device and an available
CLEAR® network.

Magnifier displays the information specific to the feature
located beneath it.

Main menu (right softkey) displays a grid view of your most
popular applications (Favorites). Functions the same as
touching the Applications Shortcut icon (88 ) from the left
of the screen.

Title Bar Icon Overview

The following table lists the onscreen icons, shown within the
Title Bar, and their descriptions.

Indicates the battery is fully charged. Tap this
icon to display the Battery power tab.

Indicates the battery is fully discharged. Tap this
icon to display the Battery power tab.

Indicates the device is connected to a power
cable and is currently being charged.

Indicates the speaker is turned on. Tap this icon
to access the onscreen Volume slider and adjust
the volume level.

Indicates the speaker is set to vibrate only. Tap
this icon to access the onscreen Volume slider
and adjust the volume level.

Indicates the speaker is turned off and vibrate
is disabled. Tap this icon to access the onscreen
Volume slider and adjust the volume level.

Indicates the device is working to establish a
wireless connection.



Indicates the device failed to establish a
wireless connection.

Indicates an active Mobile WiMAX connection
has been established and you are currently
using an active WiMAX broadband connection.

Indicates an active Wi-Fi connection.

Indicates an inactive Wi-Fi connection.

Indicates an error or issue with the device and
its functionality. Touch the icon to reveal the

e
ERE S NE

Indicates an inactive Mobile WiMAX connection.

Manually Locking the Device

This manual process temporarily locks the device without the
need to utilize a password.

1.

Single press the Power button (@) to turn off the
screen but keep the device on in the background.
—or—

Press and hold the (n) (right action key) to lock the
screen from accidental usage, but keep the screen on.

Manually Unlocking the Device

1.

Single press the Power button (@) to turn the screen
back on.

—or—

Touch Unlock (left softkey) and tap the onscreen grey
Unlock button.

notification.
—or—
Locking Your Device Press and hold the (n) (right action key) to unlock the
The device can be locked either manually or automatically via the screen.

Settings menu.
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Setting Up an Automatic Lock State

When you setup an automatic lock on your device, it requires a
password be entered prior to returning to normal operation.
When a password is set up, the device can be locked
immediately upon command, configured to lock after a specified
period of inactivity, or after the LCD blanks out.

1. From the Today screen, touch Start > Settings.
2. Touch the Personal tab and tap Lock ( /9 ).

3. Set up a timeout value by touching the Prompt if device
unused for field then use the drop-down list to select a
value (amount of unused time required before you are
prompted for a password if the device becomes idle).
Enabling this option activates the remaining fields.

4. Touch the Password type field and enter the desired
information:

 Simple PIN: must be at least four characters in length and cannot
contain a simple sequence such as 0000, 1111, or 1234,

o Strong alphanumeric: must be at least seven characters in length
and must contain at least one character from each of the following
categories: uppercase/lowercase letters, numerals, and symbols.
Examples of strong alphanumeric passwords are sh?8A13 and
%S$VH5hW.

21

5. Touch the Password field then use the QWERTY keyboard
to enter the desired password.

6. Touch the Confirm password field then use the QWERTY
keyboard to re-enter the same password.

7. Touch m to save your password.
8. Touch Yes to confirm your selection.
Creating a Password Hint

One method of making sure you don’t accidentally forget your
new password is to use the Hint feature.

1. From the Today screen, touch Start > Settings.
2. Touch the Personal tab and tap Lock ( P ).

Note: If you have previously created your password, you are prompted to
touch the onscreen password filed, use the QWERTY keyboard to enter
your password, then touch Unlock before you can make any updates or
changes.

3. Touch the onscreen Hint tab and use your QWERTY
keyboard to enter a hint for your password into the dialog
box.



Note: This hint may be visible to others, so do not enter your password into
this field. The hint you set will only appear after five consecutive
incorrect passwords have been entered.

4. Touch m to save your new password hint.
Unlocking the Device after a Timeout

1. From the Password screen, touch the password field.

2. Use your QWERTY keyboard to enter your Lock password.

3. Touch Unlock (left softkey) to unlock the device.
Calibrating your Touchscreen

It is important to calibrate your monitor properly so that your
touches are read accurately by the device.

-,

1. From the Today screen, touch Start (l\Lj ) > Settings.
2. Touch the System tab and tap Screen (\@ ).

3. Use your Stylus pen to touch the Align Screen button.

4. Firmly and carefully touch the center of each crosshair and
repeat this process until the calibration session has
completed (this could take 2 - 3 repetitions).

5. Touch to complete the process and return to the
previous screen.

Menu Navigation

You can tailor the device’s range of functions to fit your needs
using both menus and widgets. Menus, sub-menus, and features
can be accessed by scrolling through the available onscreen
menus.
Opening an Application
» Tap the associated onscreen icon.
® Touch or m to exit from the current menu and retur to
the previous screen.

o Press Wl (right action key) to exit from the current location or
function, and return to the Main Menu.

Note: These actions only exit from (close) the current application while still
maintaining them active in the background.

Closing an Application

Applications are only closed (no longer active) when they are
exited via the application’s own Menu options. Simply touching
or m will only minimize the current application and
keep it running actively in the background. These, still running,
applications can utilize your device resources, slow down your
device and drain your battery faster.
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To close your applications:

1.
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Touch the application’s softkey option Menu > Exit.

—or—

Press and hold n (left action key) to launch the

TaskSwitcher application.

o This application visually displays any applications currently running
in the background.

o [t also provides the option to either bring a selected application
forward or End (close) it.

Flip through and center the desired application. The name
will appear above it.

Touch either End (to terminate the current app) or End All
(to close all background applications). For more
information, refer to “Using TaskSwitcher to Close
Applications” on page 88.

Navigating Through Menus

As you navigate through a menu, options display on the screen
as scrollable lists. Menu tabs (located at the bottom of most
screens, provide access to additional screen options).

To navigate a scrollable list:

1.
2.
3.

From the Today screen, touch Start (ﬂ'[j).
Touch and gently press an onscreen option.
From the available list of options you can either:

 Touch an onscreen entry to activate it.

 Firmly press and slide your finger up or down the screen to scroll
through lists of menu items.

 Navigate through a long list by pressing either volume key up or
down.

Note: Tapping or touching individual entries on the list opens the list entry.




Quick Navigation Among the Device Panels

Each of the available shortcuts (seen below) opens an associated
panel that can be activated by flipping across the page as seen
below.

Touch or Tap » Inasingle motion, touch and drag up or down along either side
onscreen options

(left or right) of the current panel. This actions creates a

cube-like effect as you flip among the different panels.

Scrolling Through
Options/Selections

Note: Scrolling requires that you press firmly on the screen then drag. When

scrolling through a list (see adjacent image) make sure not to touch or
press individual entries on the list as this will open the list entry.
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Panels display the associated features, functions and
shortcuts for shortcut.

Shortcuts provide access to each of the five available
panels.

Applications panel provides a grid view of the 12 preferred
Main menu application shortcuts (Favorites). These icons
can be customized to display any 12 application shortcuts
(from those available).

Favorite Contacts panel displays a scrollable list of currently
available Favorite Contacts cards.

Using the stylus, select the desired level on the slider

located under Volume.

 Touch either On (activate the device sounds), Viibrate (only a
vibration is felt - no sound), or Off (mutes both onboard speakers

and tums off the vibration feature). The onscreen volume icon
changes accordingly.

Select again to exit.

Note: You can also press and hold the slider, or the side volume keys to move

the selection up and down along the slider range.

Updating Sound Events

The Sounds & Notifications page allows you to select the actions

Adjusting Your Volume Levels for which you hear sounds and how to notify you when those

You can set the volume for the device notifications by following different events occur.

these steps: 1. From the Today screen, touch Start (,fé’ ) > Settings.
1. From the Today screen, touch (located at the top of

your screen). A menu then displays with the onscreen
slider needed to adjust the device volume.

2. Touch the Personal tab, then tap Sounds & Notifications.
3. Activate sound notifications for any of the following events
by touching any of the following:
o Events (warnings, system events)
 Programs and Notifications (alarms, reminders)
o Screen taps (Soft or Loud)
o Hardware buttons (Soft or Loud)
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Touch the Notifications tab to then assign specific audio
files (or vibrate) to play for specific applications or actions.

Touch the Event drop-down list and select one of the
following events:

e ActiveSync: Begin sync

o ActiveSync: End sync

¢ Beam: Autoreceive

e Connection disconnected

e Connection established

o Messaging: New e-mail message

¢ Reminders

o Wireless network detected

Activate any of the following notification actions by tapping
the field adjacent to each:

o Play Sound

* Repeat

o Display message on screen

o Flash light for

o Vibrate

Touch m to save your new settings and return to the
Personal tab.

Formatting the Device’s Memory

Both the internal device storage location (Main Storage) and
microSD card (Storage Card) can be cleared of content via a Hard
Reset and reformat process.

The Main Storage (My Device) location has only ~90 MB of
storage capacity to contain your installed applications and files.
Once this capacity is reached, you can obtain an error message
indicating you need to clean up the Main Storage location (you
have reached the 90 MB limit of your storage capacity and can
no longer install additional applications).

The My Storage location contains as much storage capacity as
provided by your internal microSD card. If given the option for the
destination of installed applications and files, it is recommended
you use the My Storage location on the microSD card.

1. From the Today screen, touch Start (.'L/’ ) > Settings.
2. Touch the System tab and tap Hard Reset.
o The Memory tab refers to the device’s internal memory storage.

o The Storage Card tab refers to the installed microSD card’s
storage.

Note: This can also be accessed from a similar menu by using the following
steps: tap the Applications shortcut > Basic Settings.

3. Touch the Memory tab.
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4. Tap either an individual onscreen Reset button for either
the Main Storage or My Storage locations.
—or—
Tap Clear Memory to delete both locations.

o |f selecting the Clear Memory option, you will need to type in ‘Yes’
within the onscreen field and then tap Yes to continue.

7g  Settings

e 471238 ok

B Main Storage 9125 MB

[ — ) I Ty
delete all of your data and

26.36 MB €480 MB reset all settings o
mamufacture default

W My Storage A10.54 MB

| |[Fest]  [Ceearvomoy ]

897 B F|ELAT ME

Hemory | Storage Card
L]

5. Tap Yes to continue with the format process.

Important!: If you clear all memory, all previously configured settings and
device data will be deleted and the unit will be reset to its factory
defaulted settings. You will then need to setup the device again
(page 4).
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Formatting the microSD Card

After you have installed an optional microSD card, you can then
use the Format feature to clear any pre-existing information and
then use it for data storage.

1. From the Today screen, touch Start (i{jj ) > Settings.
2. Touch the System tab and tap Hard Reset.
3. Touch the Storage Card tab and tap Format.
4. Tap Yes to continue with the format process.
For more information, refer to “Formatting the microSD Card” on
page 55.
Entering Text Using the QWERTY Keyboard

Your device provides convenient ways to enter words, letters,
punctuation, and numbers whenever you are prompted to enter
text (for example, when entering information into a field, surfing
the Web, or when using Microsoft® Outlook® and Text
Messaging).

To access the QWERTY keyboard

1. Firmly grasp the front and back of the Mondi with both
hands.



2. Inasingle motion, use your thumbs to slide the top section When you display a screen where you can enter text, use the
of the device up to open, as shown in the following keyboard to enter different character types:

illustration.

Note: When the key entering mode is changed to either Shift or Fn, their
corresponding icons are shown adjacent to at the bottom of the

screen.

Softkey (right)

Softkey (left) ?(‘g’ﬁfg‘r’ ’

The built-in QWERTY keyboard supports quick and easy text
input, just as you would when using a computer’s keyboard.
Mondi also provides an onscreen virtual QWERTY keyboard that
functions in the same fashion.

Function: Allows you to use characters displayed at
the top of the QWERTY keys.
Examples: 1,5,0, $, @, #, ?

CAPS/SHIFT: Converts the alphabetic character into
uppercase. Changes the text input mode between
Upper/Lower case modes.

Symbol: Launches the Symbols page from where
you choose from an onscreen list of symbols and
other character sets. Touch an onscreen item

to insert it into your text field.

Delete: Deletes the previous character, similar to
the backspace key on a computer keyboard. This
key has two different functions: in its default mode,
it functions as a 'backspace’, within Fn mode, it
functions as a 'delete’ key.
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Enter: Moves the insertion point to the next line in a
message.

The keyboard provides dual-use keys labeled with alphabetic
characters on the lower half and numbers and symbols on the
upper half. Press the key combination corresponding to the
character you want to enter.

Entering Characters

Characters can be entered using either Uppercase or Lowercase.

1. Slide out the QWERTY keyboard and press to make
the next entered character uppercase. Characters then
revert back to lowercase after the next character is typed.

2. Press the desired text key.

 For example, to enter the word “Sam”, type the keyboard sequence
below.

o If you make a mistake and enter the wrong character, press
t0 erase a single character. Press and hold to erase an
entire word.
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Lt J°s] al' v
Sam

3. To enter all uppercase characters, press Q) twice to
maintain all consecutive characters in uppercase.

Cs] Al v
SAM
Entering Numbers

The keyboard can be used to enter numbers, letters, and
symbols. Although these keys default to text (letters), numbers
can be input by using [ in conjunction with the correct
number key.
1. Press - to input the character displayed on the top row
of the next QWERTY key pressed.



Press the desired key.
To only enter all top row characters, press . twice.

o For example, to enter “11:30”, you would use the keyboard
sequence shown below.

o If you make a mistake and enter the wrong character, press
to erase a single character. Press and hold toerase an
entire word.

11:30

Entering Symbols

Symbols can be entered from the keyboard (using the [[EE) key)
or from the Symbols page (accessed using the key).

Note: To use &4 (Symbols page), the Text Input Mode must be set to

Samsung Keypad.

Position the cursor where you want the symbol to appear
within your message.

Press to launch the onscreen Symbols page. There
are up to eight pages of symbols (accessible by the bottom
left button. Ex: 1/8 thru 8/8).

Touch an onscreen entry to insert the selected symbol.
There are multiple pages of available symbols.

—or—

Choose to insert a QWERTY keyboard symbol by
positioning the cursor where you want the symbol to
appear within your message.

Press - and then press the key for the symbol you
wish to insert. This method uses the symbols etched on
the corresponding QWERT key.

S

Pat@
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Entering Text using the Onscreen Keyboard

In those onscreen pages where text can be entered into either
fields, strings, or messages, the device also provides access to
an onscreen virtual QWERTY keyboard.

1. From a place where you can enter text, touch the onscreen
text field.

2. Touch to pull up an onscreen keyboard.

3. Make your character selections using the same methods
discussed within the previous Entering Text, Numbers, and
Symbols sections.

4. Once complete, touch again to close the onscreen
keyboard.

Adjusting Text Input Settings

The Mondi does not, by default, use the standard Microsoft input
method but rather an XT9 input method. This method can be
configured via the Mondi Input settings page.

XT9 is a new text input software that allows you to easily enter
text faster on a Windows Mobile-based device. XT9 allows for
word prediction, word completion, and real-time spelling
corrections.
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1. From the Today screen, touch Start (.JLf ) > Settings.
Touch the Personal tab, then touch Input.
Touch the Input Method tab.

With Samsung Keypad selected, touch the onscreen
Options.. button.

Eal AN

5. Configure the desired XT9 settings:

o XT9 Settings: allows you to select your input language, adjust your
word completion, spelling correction, auto-substitution, and
regional correction settings.

o XT9 Dictionaries: provides access to the built-in dictionaries: Xt9
My Words and XT9 Auto-Substitution.

o About XT9: describes the XT9 input software version information.

o XT9 Help: provides end-user onscreen help for the XT9 input
software.

6. Touch Done (left softkey) or tap m to save your new
settings and return to the previous page.

Note: Some of these features may not be compatible with the Samsung
Keyboard Input method.




Widgets
The MobileWidget page (via the Widget Bar) provides quick
access to mini-programs (widgets). This bar gives you
information at a glance and provides easy access to frequently
used tools such as (Analog Clock, Digital Clock, Calendar, Music
Player, Photo, Dual Clock/World Clock, Today’s Events, Wireless
Manger, Memo, AccuWeather, Google, Yahoo Financial and Yahoo
One Search). This bar makes great use of the available space on
your device.

The Widget Bar is a pane on the bottom of the Widget Desktop
area that houses user-selected mini-applications and keeps
them organized and always accessible.

You can easily customize the Widget area by either docking these
mini-apps to the Widget Desktop area or placing them back
within the Widget Bar for later use.

Widget Bar Navigation
You can drag the widgets to the desktop to use the application or

feature, then drag it back to the Widget Bar when you are
finished.

Accessing the Widget Bar

1.

From the Today screen, touch Start (.’fj’ ) > Programs >
Widget.

—or—

Quickly press and release the left action key (n ).

Tap the grey tab’s blue arrow (bottom of the screen) to
temporarily display the Widget Bar tab.

Tap the tab’s blue arrow again to close the Widget bar or
wait a few seconds for it to close automatically.

Adding and Deleting Widgets from the Desktop

1.

From the Today screen, touch Start (."j ) > Programs >
Widget.

—or—

Quickly press and release the left action key (n ).

o Widget Bar - provides a horizontal list of available widgets.
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o Widget Desktop - is the available workspace where you can place
any desired widget apps. Once placed on the Widget Desktop, they
are immediately available and active. Their position on the desktop WED 29 APR
can easily be changed by, in a single motion, touching and
dragging to a new location.

Widget Bar  Desktop Pages ~ Widget Desktop e
2. Touch and hold the widget (1). 5. Repeat this process for any additional widgets you wish to
3. Inasingle motion, touch and drag an available widget add.
from the Widget Bar (1) to the Widget Desktop area (2). —-or—
4. While still holding the icon, in a single motion, drag it over To remove a Widget from the Desktop area (2), touch and
to the new location on the Widget Desktop area and drag the onscreen widget and drag it back into the Widget
release your finger from the screen (2). Bar (1).
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Note: Widgets are not activated by default on the device but must first be
activated via the Widgets menu.

Placing Widgets on Separate Pages

The three buttons at the top of the Widget Desktop correspond to
available pages that can contain Widgets. Since not all the
available Widgets can be displayed on a single page, these allow
you to select from one of three available pages

1. From the Today screen, touch Start ( .’5’ ) > Programs >
Widget.
—or—
Quickly press and release the left action key (n ).

2. Touch any of the three Desktop page icons (at the top of
the page) to display one of three available Desktop pages.
You can place (anchor) a selected Widget to any of these
active pages.

3. Inasingle motion, touch and drag an available widget
from the Widget Bar (1) to the Widget Desktop area (2).

Rearranging Widgets within the Widget Bar

1. From the Today screen, touch Start (i'L,’ ) > Programs >
Widget.

2. Inasingle motion, touch and drag a widget from its
current location on the Widget Bar and move it to a new
position either between two existing Widget icons or at the
beginning/end of the listing.

—or—

While still holding the icon, in a single motion, drag it away
from the widget bar (1) then drag it back into its new
location in the list.

Activating a Widget
1. Locate your widget (whether it is still docked in the Widget
bar or in another location).

2. Touch the Desktop Widget icon to activate the
mini-application (widget).
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Widget Icons

The following table contains a description of each available
Widget, it’s function, and how to navigate to that particular
application. If the application is already described in another
section of this user manual, only a cross reference is then

provided.

Note: Some of these Widgets require an active broadband connection prior to
activation and use.
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Analog Clock: displays the current time on an
analog clock.

¢ Touch, drag and drop the Analog clock onto
the desktop to view the time in an analog
format.

Digital Clock: displays the current time on a
digital clock.

¢ Touch, drag and drop the Digital clock onto the
desktop to view the time in a digital format.

Calendar: allows you to access the Calendar
feature and choose a specific date by tapping
from a date from an onscreen calendar.

With the Calendar feature, you can:

o Consult the calendar by day, week, month,
year, or Agenda.

o Set schedules and note anniversaries.
o Write memos to keep track of your schedule.
o Setan alarm to act as a reminder, if necessary.

o For more information, refer to “Calendar” on
page 68.

Multimedia Player: allows you to launch the
Multimedia Player application where you can
play music and video files stored both locally
and within the microSD card to then control
their playback.

e Touch, drag and drop, then tap the Music
Player icon to launch the multimedia player.

o Touch the arrows on the widget to control the
playback of the currently active song or video.



Photo: allows you to view the list of device images,
received in messages, or taken by the camera.
You can then set/assign the image as the
current wallpaper for the Widget Desktop.

o For more information, refer to “Widgets” on
page 32.

Dual Clock/World Clock: displays current time in
both the current location and within another
user-defined international location. Via the
Clocks application, you can set alarms, assign
anniversary dates, access the stopwatch
feature, and view the World Clock.

You can also view times from other parts of
the world.

¢ Touch, drag and drop the World Clock onto the
desktop to view the time in dual locations.

* For more information, refer to “Clocks” on
page 81.

n
U

m Today’s Events: allows you to review the

Calendar events for the current day.
With the Calendar feature, you can:

o Consult the calendar by day, week, month,
year, or Agenda.

Set schedules and note anniversaries.

* Write memos to keep track of your schedule.

Set an alarm to act as a reminder, if necessary.

* For more information, refer to “Calendar” on
page 68.

Wireless Manager: Launches the Wireless
Manager application that allows you to activate
the Airplane mode, access/alter and manage
your Wi-Fi, Bluetooth, and Mobile WiMAX
connections.

Touch, drag and drop, then tap the Wireless
Manager icon to launch the Wireless Manager
application.

For more information, refer to “Widgets” on
page 32. For more information, refer to
“Communication and Connection” on

page 38.

Basics 36



Memo

Accu
Weather
-com
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Memo: launches the Notes application where
you can then create, store and review
previously created notes/memos.

o For more information, refer to “Widgets” on
page 32.

AccuWeather: uses your current data
connection to access and display an onscreen
popup containing real-time weather information
for a specified location. You must have an active
data connection to use this feature.

o For more information, refer to “Widgets” on
page 32.

Google: launches a Google™ search field
where you can search the Web by entering a
search string (using your QWERTY keyboard).
You must have an active data connection to use
this feature.

o For more information, refer to “Widgets” on
page 32.

S

Yahoo Finance: uses your current data
connection to display an onscreen window
containing the latest Yahoo financial news.

o For more information, refer to “Widgets” on
page 32.

Yahoo One Search: launches a Yahoo search
field where you can search the Web (US or
International) by entering a search string (using
your QWERTY keyboard). You must have an
active data connection to use this feature.

o For more information, refer to “Widgets” on
page 32.



Section 3: Communication and Connection

Communication Setup
Your device is capable of obtaining broadband Internet Access via
either of these two available methods:
o Wi-Fi access
o Mobile WiMAX connection

Note: Quick Access (activate/deactivate & configure) to the Airplane Mode,
Bluetooth, Wi-Fi and Mobile WiMAX CM features is available from the
Today screen by touching (88 ) > Basic Settings.

Wireless Manager Overview

Wireless Manager application that allows you to activate the
Airplane mode, access/alter and manage your Wi-Fi, Bluetooth,
and Mobile WiMAX connections.

Accessing the Wireless Manager Page
1. From the Today screen, touch Start ( m’fj ) > Settings.

2. Touch the Connections tab and tap Wireless Manager

@

From the Title bar, touch the connection icon (4:;(), then
touch the blue Wireless Manager link.

3. Locate the desired connection method (Bluetooth, Wi-Fi or
Mobile WiMAX [see adjacent image]).

Wireless Manager
Widget

%2 | Wireless Manager

Airplane Mode

Bluetooth
Wireless Manager
Page

Wi-Fi

Mobile WiMAX CM

Mobile WiMAX CM Settings
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Accessing the Wireless Manager Widget
1. From the Today screen, touch Start (.JL/’ ) > Programs >
Widget.
2. Inasingle motion, touch and drag the Wireless Manager
widget (@) from its current location on the Widget Bar
and move it to the Widget Desktop.

Communication Methods - Overview

The two available methods for connectivity are:

* Mobile WiMAX - is developed primarily for wireless metropolitan area
networks (WMANS).
— provides broadband speeds without the need for cables.
— Allows for a wider range of mobility.

Note: * Please check with your Mobile WiMAX provider for available local
broadband speeds.

o Wi-Fi - has primarily been developed for wireless local area networks
(WLANS).
— Transmission range of up to 100m.
— Wi-Fi networks have limited range compared to Mobile WiMAX.
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Airplane Mode

Airplane Mode allows you to use many of your device’s features,
such as Games, Office, Multimedia, etc., when you are in an
airplane or in any other area where data usage is prohibited.
When your device is in Airplane Mode (x ), it cannot send or
receive any data or access online information.
1. From the Today screen, touch Start ( i,'L] ) > Programs >
Widget. -
2. In asingle motion, touch and drag the Wireless Manager
widget ( ) from the Widget Bar to the Widget Desktop
area.

3. Touch the Airplane Mode field to toggle its activity state

between On (X ) or Off (&).

Note: Activating Airplane mode deactivates all Bluetooth, Wi-Fi, and WiMAX
communication.

4. Press( n) (right action key) to return to the Today screen.



Activating Wi-Fi Communication

Wi-Fi communication requires access to an existing and
accessible Wireless Access Point (WAP). These WAPs can either
be Open (unsecured) as within most Hot Spots, or Secured
(requiring knowledge of the Router name and password). The
following is a list of Wi-Fi icons displayed on the device:

? Indicates an active Wi-Fi connection.
Jh
i Indicates an inactive Wi-Fi connection.
My "
1. From the Today screen, touch Start (&7 ) > Settings.

2. Touch the Connections tab and tap Wireless Manager

@

- Or p—
From the Title bar, touch the connection icon (0'-:;(), then
touch the blue Wireless Manager link.

3. Touch ON (within the Wi-Fi area) to toggle the active state.

Establishing a Wi-Fi Connection

1.
2,

From the Today screen, touch Start (llff) > Settings.

Touch the Connections tab and tap Wireless Manager

@

Touch Menu (right softkey) > Wi-Fi Settings.

From the Wi-Fi Settings page, filter the list of available
networks by touching an available onscreen network or
expand the search by choosing one of the following:

o All Available

e Only access points

o Only computer-to-computer

Touch Menu (right softkey) > Add New... to add a new
connection, or touch an available connection to edit its
parameters.

From the Configure Wireless Network page, touch the
Network name field and use the QWERTY keyboard to enter
a name for the new network connection.
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10.

1.

12.

Select from the following security connection presets from
the Connects to drop down:

— Select The Internet if the network connects to the Interet (does not
use proxy settings).
— Select Work if the network does not connect to the Internet (uses proxy
settings).
Touch any of the remaining fields to place a checkmark
alongside their entries (checkmarks indicate activity).

o |f the network has SSID broadcasting disabled (is “hidden”), select
This is a hidden network.

o [f the connection is for an ad-hoc network, select This device is a
device-to-device (ad-hoc) connection.

Touch Next (right softkey) to continue onto the
Authentication and Data Encryption information. Use the
information provided by your Network administrator to
complete this section.

Use the QWERTY keyboard to complete this information
and touch Next (right softkey) to continue.

Complete the process by selecting the appropriate security
protocol parameters from the EAP type drop-down menu.

Touch Finish (right softkey) to complete the process.

13. Touch the Network Adapters tab to select a My network
card connects to: entry (The Internet or Work) and modify
an adapter from the list provided.

Connecting to a Mobile WiMAX Network

Mobile WiMAX provides broadband Internet access over a wider
coverage area than available with Wi-Fi or Bluetooth. Connection
to a WiMAX network requires the activation of service. During
communication to the Internet, the device uses any previously
configured wireless network connections (WiMAX or WLAN/
Wi-Fi).

Note: Mobile WiMAX connectivity is only available in limited markets and
must be accompanied by an active WiMAX service plan prior to
establishing any Mobile WiMAX connectivity.

Activating the Mobile WiMAX Hardware

Before you can establish an active Mobile WiMAX data session,
your built-in WiMAX hardware must first be activated. Once you
activate the connection via the WiMAX CM (Connection Manager),
the WiMAX connection is automatically enabled.

Note: This device is expected to achieve speeds that are twice that of 3G
wireless service. Overall internet experience will vary depending on a
number of factors including device parameters, patterns of usage,
network conditions and the characteristics of websites visited.




1. From the Today screen, touch Start ( j'L/’) > WiMAX CM.
—or—
Touch (88) from the left side of the device screen to
launch the Main Menu screen and touch Basic Settings >
Mobile WiMAX CM.

Locating your MAC ID

Your MAC ID is a device specific identification that is required
prior to gaining access to a wireless system. Your device’s
internal Bluetooth, Wi-Fi, and Mobile WiMAX components all have
a specific and unique MAC ID. It is this alphanumeric sequence
which you must obtain prior to registration of your device for use
on the CLEAR WiMAX network.

1. From the Today screen, touch Start ( .{’J/ ) > Settings.

2. Touch the System tab, then tap Version (@ ).

3. Scroll down this Version page and locate the Mobile
WiMAX section wherein you will see the MAC value listed.

4. Write down this alphanumeric string and use it during your
registration process.

Warning!: This is a unique wireless ID and should be kept secured. It is
recommended that you properly dispose of any written record of
this ID after registration.

Online setup for Mobile WiMAX Access

If you have not already created a CLEAR service account, you will
need to do so prior to connection. Without an active account,
your device only allows access to the main www.clear.com Web
page.

There are three current methods for creating a CLEAR account:
o Directly from your Mondi (page 43).

o Log into www.clear.com and click CLEAR Services.

o (all CLEAR at 1-888-888-3113 and follow the audio prompts.

Important!: It is recommended that you setup and register your device online
via a computer with access to the Internet.
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Creating an Account from within Mondi
1. From the Today screen, touch WiMAX CM (left softkey).
—or—
From the Today screen, touch Start (."Ij ) > WiMAX CM.

2. Touch CGonnect. Once successfully connected, you are
returned to the Today screen.

3. Once connected to Mobile WiMAX, launch your Opera
browser and follow the onscreen instructions. You will be
taken to the CLEAR website and prompted to create an
account. Your device MAC ID will be automatically detected
by the system.

Creating an Account from CLEAR Website

1. Log into www.clear.com from a computer.

2. Click on the CLEAR Services tab.

3. Follow the onscreen instructions to create a new CLEAR
account and assign your device’s MAC ID (page 42).

4. Once complete, return to the main CLEAR Web page and
click My Account (top of the page) to confirm your
information and activation status.
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5. Initiate a connection.

T  WIMAX CHM

Click Connect button for connect to a Mobile WiMAX network

Initiating a Mobile WiMAX Connection

Note: Prior to Mobile WiMAX usage, you must sign up for a service plan. For
service plans and coverage information, see www.clear.com.

Note: If you do not have a CLEAR account, see “Online setup for Mobile
WiMAX Access” on page 42.

If you have already set up a CLEAR WiMAX account, your Mondi MAC
ID will be detected by the system and you will then be allowed full
WiMAX access.
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1. From the Today screen, touch WiMAX CM (left softkey).
From the Today screen, touch Start (i’fj ) > WiMAX CM.

2. Touch Connect. Once successfully connected, you are
returned to the Today screen. Confirm the WiMAX icon
within the Title Bar (top of screen) indicates an active

Connection (EM).

o [f not already registered, launch a browser and then follow the
onscreen setup and connection procedures to enter the information
associated with your CLEAR account. For more information, refer to
“Online setup for Mobile WiMAX Access” on page 42.

Important!: For assistance with account activation and troubleshooting
EAR WiMAX service, contact CLEAR at: www.clear.com or
1-888-888-3113.

Bluetooth Communication

Bluetooth is a short-range wireless communications technology
capable of exchanging information over a distance of about

30 feet without requiring a physical connection. Unlike infrared,
you don't need to line up the devices to beam information with
Bluetooth. If the devices are within range of one another, you can
exchange information between them, even if they are located in
different rooms.

When the Bluetooth radio is turned off, you cannot communicate
(send or receive data) via Bluetooth. A Bluetooth connection with
an externally paired device allows you to transfer images,
Calendar dates, themes, and other data files.

To save battery life or in situations where radio use is prohibited,
such as airline travel, you can turn off the Bluetooth wireless
technology.

1. From the Today screen, touch Start ( .{L] ) > Settings.

2. Touch the Connections tab and tap Wireless Manager

@
3. Touch ON (within the Bluetooth area seen below) to toggle
the active state.

Communication and Connection 44


http://www.clear.com

"

" | Wireless Manager ' or 4% 2:16

-
b

Wi-Fi OFF

Airplane Mode

Mobile WiMAX CM

"~ WI-Fi Settings
Mobile WiMAX CM Settings

5. Touch the Devices tab and tap Add new device... from the
onscreen list. Your device then displays a list of discovered
Bluetooth devices that have been detected within its
communication range.

Note: To be detectable, external Bluetooth devices must be enabled for
visibility so the Mondi can detect the device and then connect to it. If
your device does not appear in the list of available devices, make sure
this feature is active on the target device.

4. Touch Menu (right softkey) to access the Bluetooth
Settings.
Adding a Bluetooth Device
1. From the Today screen, touch Start (.’lj) > Settings.
2. Touch the Connections tab and tap Wireless Manager
@
3. Touch Menu (right softkey) > Bluetooth Settings.

4. Prepare your external Bluetooth device for communication
and detection.
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6. Touch the device you wish to pair with and touch Next
(right softkey).

o |fyour target device does not appear within the list of available
devices, touch Refresh to repeat the discovery process.

7. Touch the Passcode field, use the QWERTY keyboard to
enter the numeric passcode, and press Next (right softkey).
You are then notified the pairing is in progress.

Note: If the target device does not require a passcode, touch Next to
continue.

8. Enter the corresponding Passcode information on your
target device to complete the pairing process.



Creating a Device Name
1. From the Today screen, touch Start (.JL/’ ) > Settings.

2. Touch the System tab and tap About ( 54 ).

3. Touch the Device ID tab and double tap the Device name
field to highlight current name.

Note: You can also view the Device Name via the My Info tab within the
Bluetooth Settings page.

4. Use either the onscreen keyboard (or slide out the QWERTY
keyboard) and enter the new name for this device. For
more information, refer to “Entering Text Using the
QWERTY Keyboard” on page 27.

5. Touch the Description field to enter additional information.

6. Touch m to store the new information and return to the
previous screen.

Note: If this name has previously been assigned within the Start > Settings >
Owner Information page, this information is then updated first.

7. Confirm the Device name update by navigating to the
Bluetooth Setting - My Info tab:

e From the Today screen, touch Start (.{’\/’ ) > Settings >
Connections tab.

¢ Tap Bluetooth ( 8) and touch the My Info tab.

8. Confirm the name was correctly updated.

Device Visibility

1. From the Today screen, touch Start (.'lj ) > Settings.

2. Touch the Connections tab and tap Bluetooth (€3).

3. Touch the Mode tab and then tap the Make this device
visible to other devices box to either activate or deactivate
the visibility (discoverability) of your device by others.

 Your device becomes visible to other devices when you transmit
your device’s name to others in your area. This allows other devices
to detect your device and request a connection. If your device is not
visible, you can still detect and connect to other devices, while still
hiding yourself from others.
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Making Bluetooth Secure

When the Bluetooth Visibility on your Mondi is turned on, your
device is wirelessly transmitting its device name and status to
every device within its range. This transmission can pose a
security risk and incite unauthorized connection to your device. It
is recommended that you remain hidden unless an active pairing
is necessary.

Beaming

The process of transmitting data between two paired Bluetooth
devices is known as Beaming. Data is directly transmitted/shared
to a target device. This device must be visible and must accept
either your incoming data or agree to be paired with your device.
The Samsung Mondi™ Mobile Internet Tablet supports beaming
of several different file types:

o Windows Mobile Themes (see the User Guide for more information)
 Microsoft Excel Workbook data (page 77)

 Microsoft Word Document data (page 79)

 Calendar Events (page 70)

 Contact entries (page 74)

 Image or Video file (page 96)
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Section 4: Synchronization

Your device features a built-in ActiveSync® utility that allows you
to synchronize data between your computer and your device.
This built-in application works either with a computer-installed
version of the application (that launches when a compatible
device is connected to a target computer) or as a stand-alone
feature (requiring an active broadband connection). This software
helps keep Contacts, Calendar, Tasks, or Inbox data up-to-date.
For additional help with Synchronization between your device
and your computer, you can reference the following online
information: Windows Mobile How-Tos.

Computer Requirements

The computer to which you install ActiveSync (v4.5 or higher)

must meet the following hardware and software requirements:

o QOperating system: Microsoft Windows XP with SP1 or later, Windows
2000 with SP4, Windows XP Tablet PC Edition, or Windows Server
2003.

 Web browser: Microsoft Internet Explorer 6 or later (required).

o Storage: Hard-disk drive with 12 to 65 MB of free space. (Actual
requirements will vary depending on features selected and system
configuration.)

o |/0 Port: USB port (1.0 or higher)

o Optical drive: DVD-ROM drive

o Viideo card: VGA graphics card or compatible video graphics adapter
supporting 256 colors or more.

Note: It is recommended that you either setup a Outlook relationship
between your Mondi and computer via ActiveSync (direct connection
or wireless) and not from within Outlook.

Installation of ActiveSync on Your Computer
1. Download and install the ActiveSync application from the
Microsoft® site to your machine: ActiveSync4.5.

2. Launch the setup program and follow the onscreen
instructions.

At the end of the installation process, you will see an ActiveSync

icon appear in your taskbar.

 Synchronization will begin automatically the first time your device is
connected to your computer.

o All selected synchronization items will be copied from your computer
1o your device and Windows Explorer will create a shortcut to the
Mobile drive.

Once you begin the synchronization process (by connecting your
device to your computer) the Microsoft ActiveSync window will
automatically open.
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Your device will remain connected to the computer after
synchronization is complete. If any selected content is changed
on your computer (new email, photos, playlist updates, etc.)
Microsoft ActiveSync automatically re-syncs the information on
the device. You can open the device’s file directory in ActiveSync
on your computer by clicking Tools > Explore Pocket PC from the
ActiveSync main menu. You can then copy files quickly and easily
from the device to the computer, or vice versa.

Connection of ActiveSync

Your computer can assign a different profile to each device that is
connected to it via the ActiveSync application. Once you connect
your first Mondi device, it will show up as SWD-M100 within the
File > Mobile Devices menu.

1.
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Right-click the ActiveSync icon found in your computer’s
taskbar and select the Connection Settings... option.

Make sure the following options are checked and click OK:

o Allow USB Connections

o (Open ActiveSync when my device connects

Connect one end of the USB data cable (included with your
device) into the USB port on your computer.

Correct

Connect the other end into the Power/USB Data jack on the
left side of the device. (The Synchronization Setup Wizard
will launch on your computer and prompt you to set up a
sync partnership with the device.)

>

V4

Incorrect

Configuring ActiveSync

1.

From the initial Synchronization Setup Wizard, click Next
(1) to begin the setup process.

If you do not use Microsoft Exchange® (for Outlook), skip
to step 3.



To set up an Exchange Server connection, complete the
following steps.

e Check the box in the Synchronize directly with a server running
Microsoft Exchange field (2) and click Next.

Note: The information in these fields is case-sensitive. Some fields may have

already been filled in by your device upon connection to your
computer.

e Enter an Exchange Server Address (also known as the Outlook Web
Access server address) (3).

o [fyour server requires an encrypted connection, check the box for
“This server requires an encrypted (SSL) connection.”

e Enter your User name, Password, and Domain information.

e To enable automatic email synchronization, check the box for Save
password.

e Click Next to continue

From the Synchronization Options screen, check all
information types you would like to synchronize with your
device and your computer. (Contacts, Calendar, Email,
Tasks, Notes, Favorites, Files, and Media.)

Click Next to continue.

Check the box for Allow wireless data connections if you
would like to allow this connection type (usually disabled if
your device is using an active USB connection), and click
Next.

Click Finish to complete the setup process and establish
the partnership. ActiveSync will save the settings and
begin synchronizing your device with your computer based
on those settings.
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Note: Media synchronization can require that you launch Windows Media
Player to finish the process of setting up the partnership.

Setting Up Windows Media Player Sync Options

If you choose to synchronize multimedia files (pictures, videos,
and music), you will need to set up a sync partnership between
your device and your computer's Windows Media Player.

Note: The MP4 video format, although not recognized by Windows Media
Player, can be played back via the MultiMedia Player available from the
Applications panel.

It is recommended that you have the latest version of Windows
Media Player installed (at the time of print it was version 11).
(You can verify you have the latest version by clicking Help >
Check for Updates... from the Media Player menu.)

1. Verify Media was selected from within the Synchronization
Options window (described in the previous section).

2. From within the Synchronized items field (adjacent to the
Media entry) click the Setup must be completed link.
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3. In the pop-up dialog box, click Yes to begin the setup
process.

4. Launch Windows Media Player. (Your device appears
within the left pane.)

Note: If your device contains an internal microSD card, both the built-in
device storage location and internal microSD card (listed as Storage
Card) are listed as two separate device entries on the left pane.

5. Click on the Sync tab to launch the partnership process.

o |f the Device Setup screen (shown above) does not appear,
right-click on the device icon (left pane) and select Setup Syn...



6. Enter a new name for the device (as it will appear within
the Windows Media Player’s left pane) and click Finish.

For more detailed information on creating a unique device name,
see “Creating a Device Name” on page 46.
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Synchronizing Music with Windows Media Player

1. Click on any of the available library categories (such as
Artist, Album, or Songs) to display a list of all current music
files detected by Windows Media Player.

o For the purpose of this section, Genre has been selected.

Note: Songs that are copy-protected (DRM protection) will not be transferred
and can result in a transfer error message.

2. Selectasong and drag it to the Sync List section of the
application (right pane). (The available memory indicator
will change depending on the size of the selected song.)

3. When you have finished selecting songs, click Start Sync to
begin the upload process from your computer to your
device’s Music folder.

o [f this list is later updated on your computer, it will be updated on
your device during the next synchronization session.
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Connecting to the Device via ActiveSync

ActiveSync allows you to synchronize data between your
computer and your device. Synchronization compares the data
on your device with your desktop computer and updates both
your device and computer with the latest data. Before you can
connect your device to your computer via USB, you will need to
install the ActiveSync application.
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Before you continue, confirm the download and installation of the
ActiveSync application to your machine: ActiveSync4.5.

1.

From the Today screen, touch Start (.’5’ ) > Programs >
ActiveSync.

Touch the Connections tab and tap External Connections.
Connect one end of the USB Data cable to your computer.

Plug the other end of the USB cable into your Power/USB
Data jack connection located on the side of the device.

Touch Sync (left softkey) to begin the synch process.
From within the ActiveSync application, click Explore.
Double-click the My Windows Mobile-Based Device icon to
reveal all the device contents (both storage card and
internal device folders).

Double-click the Storage Card folder, then navigate to
MEDIA.

Open the MEDIA folder, copy your selected video files and
paste them into this folder.

For detailed information about using ActiveSync to setup your
exchange email services, see “Using ActiveSync to Configure
Your Outlook Exchange Settings” on page 64.
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Loading Files to Your microSD Card

Verify your microSD card is securely installed into the device. For
more information, refer to “Installation of the microSD Card” on
page 9.

Before using your device’s mass storage capabilities, you need to
prepare your device’s data services to synchronize with your
desktop or laptop computer.

<N

Correct

Incorrect

Once the device is connected to the computer, you can transfer
your data to or from the microSD card. One method of data
transfer involves the detection of the device as an external
storage device, method two involves using the ActiveSync®
application to synchronize file between your device and your
computer.

The device can be configured to communicate with your
computer as an extension of your computer by using the
ActiveSync utility which is used to synchronize computer
applications with your device.

Reviewing the microSD Card Information
1. From the Today screen, touch Start (n’fj ) > Settings.
2. Touch the System tab and tap Memory.
3. Touch either the Main or Storage Card tabs to reveal
detailed memory information:

o Main tab - reveals the Total, In use, and Free storage sizes for
both the general Storage and Program areas.

o Storage Card tab - reveals the Total, In use, and Free storage
sizes for both the My Storage and Storage Card areas.

4. Touch m to return to the previous page.
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Formatting the microSD Card

Both the internal device storage location (Main Storage) and
microSD card (Storage Card) can be cleared of content via a Hard
Reset and reformat process.

The Main Storage (My Device) location has only ~90 MB of
storage capacity to contain your installed applications and files.
Once this capacity is reached, you can obtain an error message
indicating you need to clean up the Main Storage location (you
have reached the 90 MB limit of your storage capacity and can
no longer install additional applications).

The My Storage location contains up to 3.9 GB of storage
capacity. If given the option for the destination of installed
applications and files, it is recommended you use either the My
Storage location or the microSD card.

1. From the Today screen, touch Start (i{ﬂ ) > Settings.
2. Touch the System tab and tap Hard Reset.
© The Memory tab refers to the device’s internal memory storage.

o The Storage Card tab refers to the installed microSD card’s storage.

3. Touch the Storage Card tab and tap the onscreen Format
button.
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4. Tap Yes to continue with the format process.

Important!: If you continue, all data will be erased from the microSD card.

5. Confirm the capacity bar is now all grey (indicating there is
nothing currently stored on the microSD card).

Using the Device as External Storage
1. From the Today screen, touch Start (’.”’3/ ) > Settings.
2. Touch the Connections tab and tap External Connection.

3. Connect one end of the USB Data cable to your computer.



Plug the other end of the USB cable into your Power/USB
Data jack located on the side of the device.

—or—

From the Today screen, touch Application (88) > Basic
Settings > USB.

Tap Mass Storage and select either My Storage (internal

storage) or Storage Card (microSD card) as the destination.

Touch el to save your setting and initiate USB Mass
Storage Mode. (Wait for the connection to be completed.

Double-click this removable drive and view the available
folders. It is recommended that you create some folders to
contain your media and data content. Below is an example
of some possible folder names:

o DCIM - default location for pictures and videos shot with the device.
Created once a picture is taken with the device.

o MEDIA - default location for multimedia video files (user-defined).
o MUSIC - default storage location for music files (user-defined).

o OTHERS - used for data storage of any other file type
(user-defined).

When connected, your computer will automatically detect Note: If any of these folders is not automatically created, access the device
your device.) via ActiveSync and manually create them.

7. Once your computer has detected the device and properly
installed the USB Drivers, return to your Windows desktop,
open Windows Explorer and locate the removable drive
now assigned to the detected microSD card.

9. Open the MEDIA folder, copy your selected video files and
paste them into this folder.

10. Once complete, touch the onscreen EXIT button to
terminate the Mass Storage Mode.

Note: After formatting the microSD card, all folders and files are deleted.
Only after taking a photograph using the Mondi is the DCIM folder
created on the card.

Warning!: Formatting either the “My Storage” or “microSD card” from your
computer may result in a performance decrease. This action
should be done via the Mondi Hard Reset page.
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Viewing files on microSD card via Mondi
1. From the Today screen, touch Start (ifj/ ) > Programs >
File Explorer.
2. Touch the navigation drop-down menu at the top-left of the
File Explorer screen (seen below).

% | File Explorer Fadt ERTTINS. 4

a;snwn , Hame +

® My Documents

i My Storage
! Sterage Card

|| Templates

up [ ] Menu

3. Choose a storage location:
o My Device (for programs 90MB)
o My Storage (Mondi Internal Storage)
o Storage Card (inserted microSD card)
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Touch Up (left softkey) to go up a level in the folder
hierarchy structure.

—or—

Touch Menu (right softkey) to access the File Explorer
menu options.

Tap a file to then launch it within an associated application.



Section 5: Email Setup

Setting Up an IMAP or POP3 Account

To send and receive email messages through an ISP (Internet
Service Provider) account, or to use the device to access your
corporate email through a VPN (Virtual Private Network), you will
first need to set up both an IMAP (Internet Message Access
Protocol) and/or a POP3 (Post Office Protocol) account.

Note: You must first have an active Internet connection prior to initiating the
setup process. If you want to send and receive email messages
through an ISP account, or if you wish to use your device to access
your corporate email through a VPN, you will first need to set up/create
an IMAP (Internet Message Access Protocol) or a POP3 (Post Office
Protocol) account.

1. From the Today screen, touch Start (.‘:’j ) > Messaging.

2. Touch Setup E-mail or highlight the option and tap Select
(left softkey).

3. Use the QWERTY keyboard to enter an email address and
password. For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.

| E-mail Setup (7] |

E-mail address:

remail@anywhese.com

Passwords

[ save passord

4. Verify the Save password box is checked. This function is

activated by default to allow the device to always
remember your password during later access to this email
account.

o To prevent other users from viewing your emails, tap the Save
password box to deactivate the feature.

o The device will then attempt to determine the necessary
communication settings for both incoming and outgoing email
messages.
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Touch Next (right softkey) to continue to the next screen
where you can enable the Try to get e-mail settings
automatically from the Internet option. This enabling allows
the device to then attempt to retrieve these settings
automatically. This process may take several minutes.

Touch Next (right softkey), if the device was able to
automatically retrieve the necessary settings, touch Next
(right softkey).

—or—

If the device was unable to automatically obtain the
settings, touch Previous (left softkey) to return to the initial
E-mail Setup screen and proceed with the manual setup
process, see “Manual Setup of a POP3 or IMAP Account”
on page 60.

Tap the Your name: field and then use the QWERTY
keyboard to enter the name you wish to use with this email
account. This will be the name used in the From field when
your emails go out to recipients.

o |f desired, use the keyboard to also update the Account display
name you wish to use for this email account.

o This name will appear within the device’s list of available email
accounts on your Messages screen.

| E-mail Satup o |

Four name:

|Myeimail |
Exarmpie: Favin Cook}

‘Account display name:
[rahca!

The name for this account on this device.

Note: Internet mail addresses carriers such as Gmail and Yahoo. The device

is able to detect the appropriate IMAP configurations for both carriers.
The Gmail fetch feature has been tested to work very well with this
device.

Touch Next (right softkey).

Touch the Automatic Send/Receive drop-down list field and
select the time interval you would like for your device to
send and check for new email.



10. Touch the blue Review all download settings link if you wish

to modify other advanced email settings and parameters.

e For more information, refer to “Editing an Email Account” on
page 62.

11. Press Finish (right softkey).

Manual Setup of a POP3 or IMAP Account

If the Automatic configuration procedures were unsuccessful, or
if you need access to an email account via a VPN server
connection, contact your ISP (Internet Service Provider) or IT
Network Administrator to obtain the following information prior to
beginning the manual setup process:

e Account type (IMAP or POP3)

e Incoming and Outgoing Mail Server Names
o Username and Password

® Domain Name

e Special Security Settings (if utilized)

You can also obtain additional email configuration tips and help
by going to: Windows Mabile How-Tos.

1.
2

From the Today screen, touch Start ( .'L/’ ) > Messaging.
Use the Navigation keys to highlight Setup E-mail (if not
already) and either touch Select (left softkey) or double tap
the option.

Use the QWERTY keyboard to enter an email address and
password. For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.

Verify the Save password box is checked. This function is
activated by default to allow the device to always
remember your password during later access to this email
account.

o To prevent other users from viewing your emails, tap the Save
password box to deactivate the feature.

o The device will then attempt to determine the necessary
communication settings for both incoming and outgoing email
messages.

Touch Next (right softkey).

Remove the check mark from the Try to get e-mail settings
automatically from the Internet option by tapping the box
adjacent to the option.

Touch Next (right softkey).

Touch the field below the Your e-mail provider option and
select Internet e-mail by tapping the entry.

Touch Next (right softkey).
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10.

1.
12.

13.

Tap the Your name: field and then use the QWERTY
keyboard to enter the name you wish to use with this email
account. This will be the name used in the From field when
your emails go out to recipients.

o |f desired, use the keyboard to also update the Account display
name you wish to use for this email account.

Touch Next (right softkey).

Use your QWERTY keyboard to enter the Incoming mail
server information and then tap the Account type
drop-down field to then select either POP3 or IMAP4.

| E-mail Setup 7] |

Incoming madl server:

IF unzure, chack vith your provcer o gat
POPTMAF sattings,

Account bypa:
POFS -

Fravious

Touch Next (right softkey).

14.

15.

16.

17.

Use the QWERTY keyboard to enter your account User
Name and Password information. For more information,
refer to “Entering Text Using the QWERTY Keyboard” on
page 27.

Touch Next (right softkey) and verify the Save password box
is checked. This function is activated by default to allow
the device to always remember your password during later
access to this email account.

 To prevent other users from viewing your emails, tap the Save
password box to deactivate the feature.

o The device will then attempt to determine the necessary
communication settings for both incoming and outgoing email
messages.

Touch Next (right softkey), then enter the Outgoing (SMTP)
mail server information.

Verify the appropriate fields are active by tapping them and
placing a checkmark alongside their entries.

* Qutgoing server requires authentication is used if you need to
use a password for outgoing mail in addition to incoming mail.
(Please contact your System Administrator for detailed server
requirements.)



18.

19.

o Use the same name and password for sending e-mail to use the
same user name and password for outgoing mail as for incoming
mail (can only be selected if the Outgoing server requires
authentication box is checked).

e Touch the blue Advanced Server Settings link if you wish to
modify other advanced emalil settings and parameters. For more
information, refer to “Editing an Email Account” on page 62.

Touch Next (right softkey), then select the time interval
within the Automatic Send/Receive drop-down field that
you would like for your device to send and check for new
email.

e Touch the blue Review all download settings link if you wish to
modify other advanced emalil settings and parameters. For more
information, refer to “Editing an Email Account” on page 62.

Touch Finish (right softkey) to complete the setup process.

Editing an Email Account

1.
2,
3.

From the Today screen, touch Start (if\/ ) > Messaging.
Use the Navigation keys to highlight the email account.
Touch Menu (right softkey) > Options and tap the Accounts
tab.

Tap the desired email account from the onscreen list to
then launch the Email Setup page.

o

Touch the Edit Account Setup link.

Either confirm the email address is correct, or use the
QWERTY keyboard to change the information, and touch
Next (right softkey).

Contents: o

[Edit Account Semup |
Sand{Risceive Schadde

Either confirm your name and account display name are
correct, or make changes, and touch Next (right softkey).
Either confirm the incoming mail server and account type
information are correct, or make changes, and touch Next
(right softkey).

Either confirm the User name and Password information is
correct, or make changes, and touch Next (right softkey).
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10.

1.

12,

13.

14.

15.

Either confirm the outgoing (SMTP) mail server information
and field selections are correct, or make changes, and
touch Next (right softkey).

From this Outgoing (SMTP) screen, confirm the correct
SMTP information and then touch the blue Advanced Server
Settings link.

From this SMTP page, enable/disable any setting you wish
by tapping the empty box adjacent to the options.

 Require SSL for Incoming e-mail to enable SSL encryption of
incoming email (if supported by the mail server).

 Require SSL for Outgoing e-mail to enable SSL encryption of
outgoing email (if supported by the mail server).

Within the Network connection field, tap the drop-down list
and select a firewall connection setting by tapping either
The Internet (open-no firewall) or Work (behind a firewall).
When you have finished making changes, touch Done

(left softkey) and then touch Next (right softkey).

Continue onto the remaining screens to Change the
Send/Receive Schedule settings (page 63) and alter the
Download Size settings (page 64).

Changing the SendIReceive Schedule Settings

1.
2,
3.

From the Today screen, touch Start (.’5’ ) > Messaging.
Use the Navigation keys to highlight the email account.
Touch Menu (right softkey) > Options and tap the Accounts
tab.

Tap the desired email account from the onscreen list to
then launch the Email Setup page.

Touch the Send/Receive Schedule link.

Select the time interval within the Automatic Send/Receive
drop-down field that you would like for your device to send
and check for new email.

Select the time frame within the Download messages
drop-down field to select the age of messages to
download from the server. (The longer the time period, the
more messages will be downloaded.)

Touch the blue Advanced Settings link.

Activate/deactivate any settings you wish to change by
tapping the boxes adjacent to each option.

o Send/receive when I click Send to automatically check for and
download new messages whenever you Send a message.



10.

11.

12,

o Use automatic send/receive schedule when roaming to
continue to check your email at predetermined intervals even if you
are in a roaming area.

Select a deletion action within the When deleting messages:
drop-down field to choose whether to automatically delete
or retain messages on your email server when you delete
those messages from your device.

Touch Done (left softkey) once you have completed your
edits.

Continue onto the remaining screens to alter the Download
Size settings (page 64).

Changing the Download Size Settings

1.
2,
3.

From the Today screen, touch Start ( ﬂ'j’ ) > Messaging.
Use the Navigation keys to highlight the email account.

Touch Menu (right softkey) > Options and tap the Accounts
tab.

Tap the desired email account from the onscreen list to
then launch the Email Setup page.

Touch the Download Size Settings link.

6. Selecta message format within the Message Format:
drop-down field. This selection allows you to view your
email messages as either HTML or Plain Text documents.

7. Select a message size limit within the Message download
limit: drop-down field. This selection allows you to limit the
size of files attached to email messages.

8. Touch Done (left softkey) once you have completed your
edits and finish the process of altering the email settings.

Using ActiveSync to Configure Your Outlook
Exchange Settings

This method of utilizing your built-in ActiveSync application
works to not only assist in the Outlook Exchange Server®
configuration process by wirelessly establishing the
communication parameters with the remote server, but also help
to then synchronize emails, contacts, and more, with your
computer’s current Outlook application.

Before you can begin this process, you must:
o Have an established data connection to the Web via either Wi-Fi or
Mobile WiMAX.
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o Work with your System Administrator to obtain the following pieces of

information:
— Exchange Server address and domain name.
— Your user name and password.

Use your keyboard (QWERTY or onscreen) to enter the
server address and touch Next (right softkey).

o [f your network requires SSL encryption, activate the This server
requires an encrypted (SSL) connection option.

1. From the Today screen, touch Start (&) > Programs > Use your keyboard (QWERTY or onscreen) to enter your
ActiveSync. user name, password, and domain name. (The password
2. Touch Menu (right softkey) > Add Server Source... is case-sensitive.)
3. Use the QWERTY keyboard to enter an email address. For
more information, refer to “Entering Text Using the
QWERTY Keyboard” on page 27. ::::‘ | )
4. Uncheck the Attempt to detect Exchange Server Settings peT

automatically box by tapping the adjacent box. This
function is activated by default to allow the device to
always try and automatically detect the connection
settings of the remote exchange server.

Download Size Satings

Leave the Save password box checked to avoid having to
enter the password whenever you log on to this account,

Note: With most secured servers, enabling this option typically returns an
error since they require a manual connection.

5. Touch Next (right softkey) to continue onto the Server and touch Next (right softkey).

Address page.
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9. Place a check adjacent to those boxes for the types of
information you wish to synchronize with the Exchange
Server, and then touch Finish (left softkey).

When the setup is complete, synchronize to retrieve your email

messages. You can also set up a sync schedule to automatically
retrieve messages.

F& | Messaging

Edit Server Settings

Chooss thea data you want o syncheoniza;
R Ty

R consacts

1 7] Calendar

= E-mail

171 Tasks

Checking Your Outlook Email from the Today
Screen

1.

Navigate back to the Today screen and touch the onscreen

Outlook shortcut to display the most currently received

email.

e This shortcut indicates how many currently unread Outiook email
messages you have. Touching this shortcut will also launch the

Messaging page where you can also access and read messages
from your other email accounts.

Touch the entry (displayed within the Magnifier) to open
the Messaging menu.

3
Ty Start

L

WiMAX CM Main menu

Outlook Email Messages
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3. Touch an email account to then display a list of unread
email messages.

4. Touch an onscreen email message to then read its
contents. Use your Stylus to move the slider (on the right of
the message) up or down to scroll through longer
messages.



Section 6: Calendar and Contacts

Calendar

Your Calendar helps organize your time and reminds you of
important events.

Adding an Event to Your Calendar
1. From the Today screen, touch Start (.JJ/ ) > Calendar.
2. Touch the left softkey to cycle between Day, Week, Month,
Year, and Agenda (full-screen table calendar view).

Note: Use the blue arrows (upper-right of screen) to cycle through the
Calendar.

3. Touch a calendar day to which you would like to add an
event and touch Menu (right softkey) > New Appointment.

4. Enter a title for the event in the Subject field using the
keyboard. (For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.)

5. Enter alocale for the event in the Location field using the
keyboard.

6.

7.

Select a time and date for the event by selecting the
corresponding fields, touching the onscreen calendar to
set the Start and End date and then using the drop-down
time field to select a start and end time.

Touch the All Day field and choose whether the event
should be marked as an All Day event.

u
vy Calendar

8.

Appaintment | Hates

Subject; Department *|al
Location: Room -
Starts; 4/30/09 1:30 PM
Ends: 4/30/09 1

Al ay: No

Oeeurs: Onoe
Reminder: Remind me [F:30PM
15  minute(s) i

Cateaories; MO ¢

Select a recurrence status for the event by touching the
Occurs field.

o Select Once, Every [Day], Day [Number] of every month, or
Every [Month Number].
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10.

1.

12.

Select an alarm time for the event by touching the
Reminder field.

o Select None or Remind me to toggle the activation state of the
reminder feature.

o Select a reminder time interval: 1, 5, 10, 15, 30, or 45.

o Select a timeframe: minutes(s), hour(s), day(s), or week(s).
Assign a Category for the new event by touching the
Categories field.

o Assign any of the following: Business, Holiday, Personal, or
Seasonal. Any combination of category types can be selected.

 Touch New (left softkey) to create a new category type by using
your QWERTY keyboard and touching Done (left softkey).

Select the number of Attendees for the event (default is No
attendees...).

o Select to add either a Required Attendee or an Optional Attendee.

 Touch either field or touch Menu (right softkey) > Add Required
Attendee/Add Optional Attendee. For more information, refer to
“Adding a New Contact” on page 72.

Select a status category for the event by touching the
Status field.
o Select Free, Tentative, Busy, or Out of Office.

13. Select a sensitivity for the event by touching the Sensitivity
field.
o Select Normal, Personal, Private, or Confidential.

14. Touch the Notes tab and use your QWERTY keyboard to
enter an optional note.

15. Touch m to save the new event and return to the
previous calendar page.

Reviewing Calendar Events

You can quickly access any calendar entries by either selecting a
current event from the Today screen or by accessing the
Calendar via the Start menu.

1. From the Today screen, touch Start (.’5’ ) > Calendar.

2. Touch the left or right blue arrows (located in the
upper-right of the Calendar screen) to scroll through
currently created events.

o |fyou don't see your event, touch the left softkey to cycle between
Day, Week, Month, Year, and Agenda (full-screen table calendar
view).

3. Touch an event from the screen to open the event.



Editing a Calendar Event

1.
2,
3.

From the Today screen, touch Start (.'H ) > Calendar.
Locate the event and tap the entry.

Touch Menu (right softkey) > Edit to open the Calendar
Event page where you can modify any necessary fields.
Touch [el{ to save the new event and return to the
previous calendar page.

Deleting a Calendar Event

1.
2,

From the Today screen, touch Start (Q’H ) > Calendar.

Find the date of your calendar event and tap the event to
display its details. (You can use the upper-right blue arrows
to cycle through your calendar dates and locate your
event.)

Touch Menu (right softkey) > Delete Appointment.....

Touch Yes to confirm the deletion or No to cancel the
operation.

Touch n to return to the previous calendar page.

Beaming a Calendar Event

1.

Verify you are actively paired to another Bluetooth device.
Make sure that device is visible and detectable. For more
information, refer to “Bluetooth Communication” on

page 44.

From the Today screen, touch Start (Q’H ) > Calendar.

Find the date of your calendar event and tap the event to
display its details. (You can use the upper-right blue arrows
to cycle through your calendar dates and locate your
event.)

Touch Menu (right softkey) > Beam Appointment.... Mondi
begins to search for visible devices within its range.
Touch the device name from the list to begin transmission.
The recipient will have to accept the incoming Calendar
event file before the process is complete.

Note: Please allow a few minutes for the device names to be completely

populated within the onscreen list.

6.

Touch [l to return to the previous page.
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Contacts

Your device’s Contacts list helps you stay in touch with
colleagues, friends and family by keeping track of all their
contact information.

Note: If your device was synchronized to your Outlook account via
ActiveSync, your current Contacts list would contain populated entries.
For more information, refer to “Using ActiveSync to Configure Your
Outlook Exchange Settings” on page 64.

Navigating within Contacts

1. From the Today screen, touch 8 (Favorite Contacts
shortcut). This reveals a scrollable listing of all currently
stored contacts.

2. In asingle motion, touch and drag a contact card across
the screen to scroll through the available entries.

3. To access the communication features for a selected
Contact:

 Tap a Contact card from the onscreen list to open the
communication bar.

 Touch a communication option to initiate that function, see
“Utilizing the Communication Bar” on page 74.
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M1 M2

Open Contact

Communication bar ~ Contact card

o Contact card - contains the contact information specific to a
particular contact.

o Communication bar - provides quick access to various
communication functions. Touching any function icon launches a
communication session with the target contact using the selected
communication method:

— Qptions include: IM1/IM2/IM3 (Instant Message string 1, 2 & 3),
VolP1A0IP2VoIP3 (Voice Over IP - Internet Telephony), and Email
(Outlook or Internet Mail).



Adding a New Contact

1.

From the Today screen, touch 8 (Favorite Contacts
shortcut).

Slide or touch an empty Contact entry to the center
position and tap the card (indicated by a Plus sign where a
picture would be). This opens the Phonebook page.

u
Ty Start

Doct (000 8
Wendy

Open Contact

Contact card
(with custom image)

Default image Empty Contact

Touch Menu (right softkey) > New.

Enter a name for the entry (using either the QWERTY
keyboard). For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.

Tap the Picture icon to assign a photo to the Contact.

e Touch the My Pictures drop-down list and select images from a
different location such as: My Pictures, My Storage, or Storage
Card.

e Touch an image from the desired location to then apply it to the
current entry.

Enter phone numbers for the current contact by touching
any of the telephone fields (Mobile tel, Work tel, or

Home tel). For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.

Enter an Email address for the current contact by touching
the E-mail field.

Enter Instant Messenger addresses for the current contact
by touching any of the IM, IM2, or IM3 fields.

Enter a VoIP ID for the current contact by touching any of
the VoIP, VoIP2, or VoIP3 fields.

Note: These VolP IDs can not be saved to the contact within the Samsung
Phonebook.
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10. Select a Category type for the current contact by touching

1.

12.

the Categories field and touching the selection field and
placing a checkmark alongside those categories you wish
to assign.

o |f new categories exist, touch Menu (right softkey) > New Gategory
to begin creating your own.

o Enter a category name and touch Save (left softkey).

Touch Save (left softkey) to save the new entry once you
have filled in all the desired fields and assigned your
categories.

Complete the process by touching the new entry from the
Phonebook list.

Editing an Existing Contacts Entry

1.

2,
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From the Today screen, touch 8 (Favorite Contacts
shortcut).

In a single motion, slide a desired Contact entry card to the
center location and touch Open Contact (left softkey).

Touch Edit (left softkey) to open the Contact’s information
page and begin making changes to those fields you need
updated.

—or—

Touch Menu (right softkey) > Edit.

Touch an onscreen field and update the information as
desired. For more information, refer to “Entering Text Using
the QWERTY Keyboard” on page 27.

Touch m to save your changes and return to the
scrollable Contacts page.

Deleting an Existing Contacts Entry

1.

From the Today screen, touch 8 (Favorite Contacts
shortcut).

Slide a desired Contact entry card to the center location.
Touch Menu (right softkey) > Delete Contact.

Touch Yes to confirm the deletion of the current entry. The
current Contact card is then reverted back to an empty
entry.



Beaming a Contacts Entry

1.

From the Today screen, touch 8 (Favorite Contacts
shortcut).

Slide a desired Contacts entry card to the center location
and touch Open Contact (left softkey).

Touch Menu (right softkey) > Send Contact > Beam. Mondi
begins to search for visible devices within its range.

Touch the device name from the list to begin transmission.

The recipient will have to accept the incoming Contact
card file before the process is complete.

Note: Please allow a few minutes for the device names to be completely

populated within the onscreen list.

5. Touch to return to the previous page.

Utilizing the Communication Bar

This bar appears once a Contact card has been tapped and
activated. These provide you with communication options
specific to the selected card.

1.

From the Today screen, touch 8 (Favorite Contacts
shortcut).

Slide a desired Contact entry card to the center location
and activate it by tapping the card once.

Tap the card again to launch the Communication Bar to
access the various communication applications. The bar is
closed when the Contact entry card is tapped again.
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Section 7: Applications

Mondi is loaded with familiar Microsoft® Office Mobile

applications such as Pocket Outlook, Pocket Internet Explorer,

MSN® Messenger, Windows® Media™ Player, Word/PowerPoint/

Excel Mobile, and several other specialty applications. In addition

to the applications, your device is Camera/Camcorder ready.
Microsoft Mobile Applications - Internet
Explorer

Use of any online feature requires that you already be connected

to the Internet by either WiMAX or Wi-Fi. (For more information,
refer to “Communication and Connection” on page 38.)

» From the Today screen, touch Start (n'f/’ ) > Internet Explorer.

Navigating the Web

1.
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Touch Menu (right softkey) > Go to Web Address. This
action highlights the Address bar at the top of the browser
page.

Enter a Web address by using either your QWERTY
keyboard or touch to display an onscreen keyboard.
Once the address is entered, press or tap the web
address from below the address bar.

Saving a Web Address as a Favorite Location

1.

From the Today screen, touch Start (i'b’ ) > Internet
Explorer.

Touch Menu (right softkey) > Go to Web Address.

Enter a Web address and press .

With the Web site onscreen, touch Menu (right softkey) >
Add to Favorites.

Touch the Name field and input a descriptive name for this
bookmark.

Confirm the Address (URL) is correct or touch the field and
enter the correct information.

Select a Folder location to house this new Favorites
Bookmark.

Touch Add (left softkey) to store the new bookmark and
return to the previous page.



Microsoft Mobile Applications - Office Mobile

Mondi is loaded with mobile versions of the following 2007 Office
applications: Excel Mobile, Word Mobile, PowerPoint Mobile, and
OneNote Mobile.

Excel Mobile Overview

Excel Mobile works with Microsoft Excel on your computer to
give you easy access to copies of your workbooks. You can
create new workbooks or copy workbooks from your computer to
your device. Synchronize workbooks between your computer and
your device (via ActiveSync) to ensure that you have the most up-
to-date content in both locations. Excel Mobile also provides
fundamental spreadsheet tools, such as formulas, functions,
sorting, and filtering.

Creating a New Excel Workbook
1. From the Today screen, touch Start (.’5’ ) > Office Mobile >
Excel Mobile.

Note: If this is your first workbook, a blank workbook is displayed after
selecting Excel Mobile.

2. Touch New (left softkey) to begin creation of a new
Workbook.

o |f there are existing workbooks on this device, the Excel Mobile file
access screen displays any previously created workbooks. To
create a new workbook, press the New softkey.

3. Create a new workbook by using your QWERTY keyboard
to enter data into respective fields. For more information,
refer to “Entering Text Using the QWERTY Keyboard” on
page 27.

e For access to additional features and functions, touch Menu
(right softkey).

4. Once you are finished, touch Menu (right softkey) > File >
Save As...

5. Choose a file Name, Folder location, file Type, file Location,
and touch Save.

6. Touch m to return to the previous page.
Deleting a Pre-existing Workbook

1. From the Today screen, touch Start (.’fj’ ) > Office Mobile >
Excel Mobile.

2. Touch an entry from the Excel Mobile file access screen.
3. Touch Menu (right softkey) > File > Delete.

4. Confirm the deletion by touching Yes. Touch No to cancel
the deletion.
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Beaming a Workbook

Workbook files can be beamed directly to another Bluetooth-
compatible device as long as that recipient is visible and
accepting incoming data.

1. From the Today screen, touch Start (ﬁ'Lj ) > Office Mobile >
Excel Mobile.

2. Touch an entry from the Excel Mobile file access screen.

3. Touch Menu (right softkey) > File > Beam.... Mondi begins
to search for visible devices within its range.

4. Touch the device from the list to begin transmission. The
recipient will have to accept the incoming data file before
the process is complete.

5. Touch m to return to the previous page.

OneNote Mobile Overview

OneNote Mobile is a digital notebook that allows you to gather,
store, and manage information in a single location.

Creating a New Note
1. From the Today screen, touch Start (ﬁ'Lj ) > Office Mobile >
OneNote Mobile.

2. Touch New (left softkey) to begin creating the new note.
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3. Use the QWERTY keyboard to create your new note. For
more information, refer to “Entering Text Using the
QWERTY Keyboard” on page 27.

4. Touch Menu (right softkey) to select additional formatting
options.
5. Complete the process by touching Done (left softkey).
Word Mobile Overview

Word Mobile works with the Microsoft Word already on your
computer to give you easy access to copies of your documents
while on the go. You can create new documents or copy existing
ones from your computer to your device. Synchronize the
documents between your computer and your device (via
ActiveSync) to ensure you have the most up-to-date content in
both locations. Use Word Mobile to create documents, such as
letters, meeting minutes, and trip reports.

Creating a New Word Document
1. From the Today screen, touch Start (f.’f] ) > Office Mobile >
Word Mobile.

o [f there are no documents on this device, a new document
automatically displays.



o |f there are existing documents on this device, the file access
screen displays. To create a new document, press New (left
softkey).

2. Use the QWERTY keyboard to create your new document.
For more information, refer to “Entering Text Using the
QWERTY Keyboard” on page 27.

3. Once you are finished, touch Menu (right softkey) > File >
Save As...

4. Choose a file Name, Folder location, file Type, file Location,
and touch Save.

e You can save a document in any one of the following formats: Word
Document (*.docx), Word Template (*.dot), Rich Text Format (*.rtf),
or Plain Text (*.tx).

5. Touch m to return to the previous page.

Accessing Word Mobile’s Options
1. From the Today screen, touch Start (.'5’ ) > Office Mobile >
Word Mobile.

o |f there are no documents on this device, a new document
automatically displays.

o [f there are existing documents on this device, the file access
screen displays. To create a new document, press New
(Ieft softkey).

2. Touch Menu (right softkey) > Tools > Options. Choose from
any of the following options:

o Default template - Allows you to select a document format such as
Megting Notes, Memo, Phone Memo, To Do, Word 97-2003
document, and Word Document (.docx) as the default document for
any consecutive new documents.

e Save to - Allows you to select the default storage location of new
word documents. Choose from among: Main memory, My Storage,
or Storage Card.

o Display in list view - Allows you to display Word files, Rich Text
Files, Plain Text Files, All Known File Types.

3. Touch m to save your changes and return to the
previous page.

Deleting a Pre-existing Document
1. From the Today screen, touch Start (iL, ) > Office Mobile >
Word Mobile.

2. Touch an entry from the Word Mobile file access screen.
3. Touch Menu (right softkey) > File > Delete.

4. Confirm the deletion by touching Yes. Touch No to cancel
the deletion.
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Beaming a Word Document

Word Documents can be beamed directly to another Bluetooth-
compatible device as long as that recipient is visible and
accepting incoming data.

1. From the Today screen, touch Start (ﬁ'Lj ) > Office Mobile >
Word Mobile.

2. Touch an entry from the Word Mobile file access screen.

3. Touch Menu (right softkey) > File > Beam.... Mondi begins
to search for visible devices within its range.

4. Touch the device from the list to begin transmission. The
recipient will have to accept the incoming data file before
the process is complete.

5. Touch m to return to the previous page.

Windows Media Player

Use Microsoft Windows Media Player® to play digital audio and
video files that are stored on your device or downloaded from the
Internet. You can play files in either an MP3 format, or in their
original Windows Media format, including files with extensions:
.wma and .wmv.
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The device provides display of video on a 4.3 inch screen
(visible). Any imported video should be scaled to fit within that
onscreen dimension and then copied into the MEDIA folder on the
microSD card.
Launching Media Player
» From the Today screen, touch Start (.llj ) > Programs >
Windows Media.

Loading a Media File into the Player
1. From the Today screen, touch Start (j'Lj ) > Programs >
Windows Media.
2. Touch Menu (right softkey) > Open File > Storage Card >
[folder location]. Use the File System screen to locate your
desired multimedia file.

Note: The location of video files is not fixed but created by users. The [folder
location] description above denotes the user-created folder housing
the media files.

3. Touch the desired media file from the available list.
4. Touch Play (left softkey) to begin playback.



Media Player Controls

Magnification Media Player Online

Volume Controls

Player Controls

With the Media Player window open, you can change or use any

of the following application functions:

» Magnification - allows you to toggle between a Fullscreen and Fit to
Page view. To exit from the Fullscreen mode, tap the screen.

» Media Player Online - provides access to the Windows Media Player
homepage where you can access other media content.

o Player Controls - provides access to the Play/Pause, Next and
Previous functions.

o Select Play to listen to a file. The Play icon turns into the Pause icon
once the file begins playing.

e Select either Rewind or Fast Forward during playback or while
paused to skip back to the beginning of the current file and to skip
ahead to the end.

o The playback slider control above the control icons adjusts the
playback progress of the selected file.
o Volume Controls - adjusts the sound level during playback.
» Touch Menu (right softkey) to access additional application
functions.

MultiMedia Player Compatibility

The Windows Media Player recognizes wmv, and avi video
formats. The MultiMedia Player recognizes avi, wmv, and mp4
video formats, as well as DivX® encoded media files. For more
detailed information on the Multimedia Player, please refer to the
online User Guide

Devices certified to play DivX video:

ABOUT DIVX VIDEO: DivX® is a digital video format created by
DivX, Inc. This is an official DivX Certified device that plays DivX
video.

ABOUT DIVX VIDEO-ON-DEMAND: This DivX® Certified device
must be registered with DivX in order to play DivX Video-on-
Demand (VOD) content. First generate the DivX VOD registration
code for your device and submit it during the registration
process.
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[Important: DivX VOD content is protected by a DivX DRM (Digital
Rights Management) system that restricts playback to registered
DivX Certified devices.

If you try to play DivX VOD content not authorized for your device,
the message "Authorization Error" will be displayed and your
content will not play.] Learn more at www.divx.com/vod.

Instant Messenger

Messenger (Windows Live Messenger®) is an instant messaging
client created by Microsoft® for peer to peer communication.
1. From the Today screen, touch Start (i’\U, ) > Programs >
Messenger.
2. Touch Sign in (left softkey) to begin the login process.
3. Read the onscreen licensing agreement and touch Accept
(left softkey).
4, Touch the E-mail address and Password fields and enter
the information associated with your Messenger account.
Use the QWERTY keyboard to create your new document.
For more information, refer to “Entering Text Using the
QWERTY Keyboard” on page 27.
5. Select a email carrier (hotmail.com, live.com, msn.com, or
Other [such as yahoo.com]).
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6. Touch Next (left softkey) to connect to the remote service
and complete the login process.
Calculator
Your device comes with a built-in calculator.
1. From the Today screen, touch Start (i'Lj ) > Programs >
PowerCalc.
2. Enter numbers using either your QWERTY or onscreen
keyboard.
Clocks

Allows you to manage various time events (Alarms,
Anniversaries, Stopwatch, and World Clock).

Creating a New Alarm Event

Your device comes with a built-in alarm clock feature that has the
the ability to create various alarm events.

1. From the Today screen, touch the Date/Time shortcut.
—or—
From the Today screen, touch Start (ﬁ'@’ ) > Programs >
Clocks.

2. Tap the Alarm tab, then touch New (left softkey).


http://www.divx.com/vod
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MultiMedia Motes

3. Touch the Alarm field and enter a unique name for this

alarm event. For more information, refer to “Entering Text
Using the QWERTY Keyboard” on page 27.

Select a repeating status for the alarm by touching either

On or Off.

Select the week day assigned to the alarm by touching the
onscreen day (Sunday - Saturday).

o |f the Repeat function was activated (ON), you can select more than
one day.

6. Touch the Time field to open an onscreen time settings

page.

Pl E ST ¢

-

(2]

B Esn

Cancel

Touch a time field entry (Hour or Minutes) to activate the
selection.

Touch either the blue circle (below the grey slider) or the
slider itself, and drag it either left (to decrease the value) or
right (to increase the value).

e Drag and hold the slider at one end to increase the incremental
value adjustment. The further you drag the slider to one end or
another, the faster the counter changes.

 You can also touch the + or - buttons to accomplish the same
action. Touch and hold these buttons to increase the speed of the
time change.
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Touch Done to complete the time assignment.

10. Select a snooze setting by touching the Snooze field and

1.

then selecting one of the available options (via either a tap
or by using your Up/Down Navigation keys): None, 1 Min,
3 Min, 5 Min, 7 Min or 10 Min.

Select an alarm sound (Ring tone, Vibrate, or System
generated sound) for the alarm by touching the Sound
Profile field and selecting one of the available options (via
either a tap or by using your Up/Down Navigation keys).

o |fyou selected Ring or System, a sound field will appear below the
Sound Profile field.

 Touch an available audio file to play a sample.

12. Adjust the alarm volume by either touching and dragging

the volume slider across the screen or touching either
volume icon (+/-).

Note:

If you select a Ring or System Sound Profile, the Volume slider will
appear. If you select Vibrate, no Volume adjustment is possible.

13. Touch Done (left softkey) once you have finished creating

the alarm.

ActivatinglDeactivating an Alarm

1.

From the Today screen, touch Start (i'fJ, ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the Alarm tab, then touch either the ON or OFF (at the
right of the tab) to toggle the active state of the selected
alarm event.

Deleting an Alarm Event

1.

From the Today screen, touch Start (f.{lf ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the Alarm tab, then touch Menu (right softkey) > Delete
Mode.

Tap the adjacent to the alarm event you wish to
delete.

 To delete all existing Alarms, touch Delete All (ieft softkey).

Touch Yes to confirm the deletion of the selected alarm.



5. Touch Done (right softkey) to exit from the Delete Mode if

there are remaining alarm events.

Creating a New Anniversary Event

Your device comes with a built-in Anniversary feature that
provides the ability to create reminders for specific anniversary
events based on a calendar date (versus a time event).

1.

From the Today screen, touch Start (.'5' ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the Anniversary tab, then touch New (left softkey).

Touch the Name field and enter a unique name for this
anniversary event. For more information, refer to “Entering
Text Using the QWERTY Keyboard” on page 27.

Touch the Date field to open an onscreen calendar from
where you can select a date for the event by tapping a day
from the desired month and touch Done (left softkey).
Touch the left and right arrows atop the calendar to move
to either the previous or next month.

da
]

Clocks

14
21 a2
27 28 29

Today : 11/ 52008

Cancel

5. Touch the Time field to open an onscreen time settings

page to adjust the time settings, see “Creating a New
Alarm Event” on page 81.

Touch the Repeat field and select a repeating status for the
anniversary event by touching either Annually, Monthly or
Weekly.

Select an alarm sound (Ring tone, Vibrate, or System
generated sound) for the alarm by touching the Sound
Profile field and selecting one of the available options (via
either a tap or by using your Up/Down Navigation keys).
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o [fyou selected Ring or System, a Volume field will appear below the
Sound Profile field.

 Touch an available audio file to play a sample.

Adjust the alarm volume by either touching and dragging
the volume slider across the screen or touching either
volume icon (+/-).

Note: If you select a Ring or System Sound Profile, the Volume slider will

appear. If you select Vibrate, no Volume adjustment is possible.

9. Touch Done (left softkey) once you have finished creating

the anniversary event.

ActivatinglDeactivating an Anniversary Alert
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1.

From the Today screen, touch Start (’."j ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the Anniversary tab, then touch the drop-down field (at
the right of the tab) and make a selection: OFF, Today,

1 day, 3 day, or 7 day to toggle the notification setting of the
selected anniversary alert.

Deleting an Anniversary Event
1.

From the Today screen, touch Start (i'},’ ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the Anniversary tab, then touch Menu (right softkey) >
Delete Mode.

Tap the adjacent to the anniversary event you wish to
delete.

 To delete all existing Anniversaries, touch Delete All (left softkey).
Touch Yes to confirm the deletion of the selected alarm.
Touch Done (right softkey) to exit from the Delete Mode if
there are remaining anniversary events.



Using the StopWatch
Your device comes with a built-in stopwatch feature.

1. From the Today screen, touch Start (.'L{ ) > Programs >
Clocks.
—or—
From the Today screen, touch the Date/Time shortcut.

2. Tap the StopWatch tab.

3. Touch Start (right softkey) to turn on the timer.

4. Touch Stop (right softkey) to stop the timer.

Note: Times can be recorded by touching Record (left softkey)

5. Touch Reset (left softkey) to set the timer counter back to
zero.

6. Touch n to exit the application and return to the
previous screen.

Using the World Clock

This tab lets you to view the current time at various locations in
the world, and assign up to three locations as your favorites (one
being your Home location).

s': Clocks

Alasmy

Central US  05:12 P

2009/04/23{D5T)

= London,...

2009/04/2%

w London,...

World Clock Map Favorite Locations

Viewing Time Around the World

1. From the Today screen, touch Start (.'L{ ) > Programs >
Clocks.
—or—
From the Today screen, touch the Date/Time shortcut.

2. Tap the World Clock tab.
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Tap the World Clock Map on the screen.

Find a city on the world map by touching one of the blue
ocean areas and in a single motion touch and drag the
map across the screen.

Double tap a city to view the current time. The selected
time zone will turn blue.

Assigning a Favorite World Location

1.

2.
3.
4.
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From the Today screen, touch Start (.'5’ ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.
Tap the World Clock tab.

Tap the World Clock Map on the screen.

Find a location and tap a city once to get the assignment
popup. This popup displays the available cities in the
desired time zone.

Touch a city form the current time zone list to then reveal
the Favorites options: Home, City 1, or City 2.

© Home - records/assigns the main area within which you reside or
your preferred time zone. By default, your device’s system time is
set to this region.

o ity 1/City 2 - record/assign two optional world locations for which
the device will keep track of their local times.

Select one the Favorite entries then touch OK (upper-right)
to save your choices and return to the World Clock tab.

 Fach Favorite location is referenced on the World Clock Map with a
colored square.

© Home is blue, City 1 is green, and Gity 2 is red.

Editing an Existing Favorite Location

1.

From the Today screen, touch Start (i’b’ ) > Programs >
Clocks.

—or—

From the Today screen, touch the Date/Time shortcut.

Tap the World Clock tab and touch one of the three
onscreen Favorite locations.



3. Touch the drop-down arrow adjacent to the Time Zone
field to then select a different city from your current time
zone.

—or—
Touch E 1o open a list of world cities from which you
can choose a new location.

Note: The DST field will reflect (activated/deactivated) if the selected area
recognizes Daylight Savings Time and can make such an adjustment
to its time tracking.

4. Touch Done (left softkey) to update and store these
changes.

Using TaskSwitcher to Close Applications

Applications are only closed (no longer active) when they are
exited via the application’s own Menu options. Simply touching
or B will only minimize the current application and
keep it running actively in the background.

Unlike most computers, wherein minimized applications appear
as blocks located along the bottom of the screen (Task Bar), on
Mondi, these, still running, applications are left to run in the
background.

As more and more applications are left running, they can utilize
your device resources, slow down your device and drain your
battery faster.

1. Pressand hold §ff (left action key) to launch the
TaskSwitcher application.

e This application visually displays any applications currently running
in the background.

o |t also provides the option to either bring a selected application
forward or End (close) it.

Access to Multimedia Player

LEEL - T

Opera Browser

End End All

Active Applications Ending Options Display
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2. Flip through the currently open applications and center the
desired application on the screen. Selected applications
display their name above the image.

3. Touch either End (to terminate the current app) or End All
(to close all background applications).

4. Touch the Display icon (bottom-right) to change the way
the currently active applications are displayed.

o (ptions are: Horizontal List or Vertical Grid.

Note: Once installed, the maps are associated to your Mondi. If these maps
were installed onto a microSD and then inserted into another device,
they would not function as they are registered to the specific Mondi on
which they were installed.

Note: The Multimedia Player can be launched directly from the TaskSwitcher
(bottom Left of screen).

ROUTE 66 Navigation

ROUTE 66™ is a ready-to-use navigation solution that comes
complete with built-in voice-guided 3D GPS navigation based on
your current location. Mondi utilizes its built-in GPS hardware to
work in tandem with the ROUTE 66 software and provide you
real-time and accurate map information, including access to
digital maps with POIs (points of interest). The application is
loaded onto the Mondi DVD and must be installed from your
computer, to a connected Mondi device. The included maps can
be loaded to either the device’s built-in storage space or to an
optional microSD card.
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Installing the Application and Maps

If you have already setup an ActiveSync connection between your
Mondi and your computer, you will have to make a small
modification to your ActiveSync settings prior to disc installation
to prevent any conflicts during setup. These setup procedures
are based on the usage of the ActiveSync 4.5 application.

1. Prior to setup, make sure your Mondi has access to the
Internet as this is necessary to complete the setup and
registration process. For more information, refer to
“Communication Setup” on page 38.

Important!: To install the maps onto your microSD card you will need a card
with at least 1GB of available space (2GB microSD card or
greater is recommended).

2. When installing the maps to the card, you will need to
establish a direct USB Mass Storage connection (vs
ActiveSync).

o From the Today screen, touch Start ( "}]) > Settings.



¢ Touch the Gonnections tab and tap External Connections. 7. Insert your Mondi DVD disc into your available DVD drive.
o Touch the Mass Storage radio box, then choose Storage Card from The splash screen should then appear on your screen.
the drop-down list. The Mondi then establishes a new USB ) .
connection with your computer and allows access to the interal 8. From the Splash screen click Additional Tools > Samsung
microSD card as an external storage location. OEM Applications > PG Utility > ROUTEG6.
* Touch {0 save the new connection type and place the device 9. From the main Route 66 application screen, click INSTALL.
into USB Mass Storage Mode.
* In this way, the Route 66 application can place the necessary files 10. Choose a language and click Next > Next.
directly onto the card. 11. Accept the licensing agreement and click Next.

Locate the grey ActiveSync icon within the Taskbar area of
the Desktop (bottom-right). The icon should be grey when
Mondi is not connected.

Right-click on the icon and select Connection Settings....
Uncheck the Allow USB connections field and click OK. The
ROUTE 66 installation requires an open USB port to
communicate with the connected device.

12. Select a language and gender for the vocal navigation

instructions (when Mondi speaks the navigational
directions) and click Next. Each language has an
associated gender (Male or Female).

13. Place a checkmark adjacent to the desired maps you wish

uploaded for use and click Next. The default is United
States and Canada.

Important!: If this field is not unchecked, the necessary connection can not
be made and you will receive an error message during setup. If
you receive an ActiveSync connection error, ignore it for now.

Note: If you receive a connection error message, set the Mondi to Mass
Storage Mode (Step 2) and click Retry.

6. Power-up the Mondi unit and connect it directly to your
computer via the USB cable. The ActiveSync icon should
remain grey after connection, if not, repeat steps 1 thru 3.
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14. Select Format storage medium and click Next. It is
recommended that the maps be installed onto a clean and
empty microSD card. Once the maps are installed, the
microSD card is then paired for use with your specific
Mondi device.

Important!: Formatting the microSD card will erase all information and leave
the card empty of data.

15. Read the onscreen popup describing the format process
and click Yes. Your microSD card is then formatted to
delete all pre-existing information and prepared for upload
of the ROUTE 66 map files and folders.

16. Click Install to begin the installation process of both the

maps to the microSD card as well as any other necessary
files.

Note: This process can take several minutes. Do not disconnect your device
from the computer. These files will occupy over 1GB of storage space
on the microSD card.

17. Click Finish to complete the installation process and exit
the wizard.
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18.

19.

20.

21,

22.

23.

24.

From the main Route 66 application screen, click EXIT >
EXIT.

Click the onscreen Exit button on the Mondi device to exit
the USB Mass Storage Mode. Tap the onscreen Yes to
complete this process.

From the Today screen, touch Start (.JLj ) > Programs >
ROUTEG6 WM.

Read the Mondi onscreen legal disclaimer and tap Accept.
Use the Up/Down blue arrows to scroll through the
disclaimer.

Tap No to exit from reading the disclaimer message again.
The Mondi then begins to use its internal GPS hardware to
obtain your current location.

Locate your ROUTEG6 Voucher code from the sticker
affixed to either the DVD sleeve or the Navigation GSG and
tap Yes.

Use either the onscreen keyboard or Mondi’s own QWERTY
keyboard to enter your Voucher code.



25. Once the Voucher code has been correctly entered, tap the
onscreen green checkmark. If this is your only voucher
code, tap No.

o |fyou have additional voucher codes, tap Yes and enter those
additional codes.

26. From the Network Connection popup, tap either Ask always
or Allow always, and tap the onscreen green checkmark.

Note: If you receive a connection error during this Voucher code registration,
exit the Route66 application, establish a new Internet connection, and
restart Mondi setup process (step 20).

27. Mondi then utilizes the currently active Web connection to
contact the ROUTEGG server, register your device,
associate it with the entered Voucher code, then locate
your current position on the selected map group.

Navigating within Route66 Application

Once the Route66 maps and application are properly installed,
the Mondi will display your current overall location, from which
you must then select a desired area and function.

1. Touch a location on the map to activate the target screen
(shown).

e You can move around a map by touching a dragging across the
screen (in a single motion).

o Once you have located a general area, touch a more specific
location to focus your search.

Zoom Qut

Target Area Map Zoom In

Main menu Target Back

2. Touch the Target icon ( Eﬂ%% ) to reveal options specific to

your selected area. Options included in the Target menu
are:

¢ Navigate to: begins a new navigation session.
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o Call (greyed out as Mondi can not make direct calls)

 Zoom to cursor: zooms the current map to indicate more detail
about the selected target location.

 Show information: displays additional popup information when
any onscreen map object is touched (street, locale, area). The
onscreen popup disappears once a new location is touched.

 Send cursor position: records your current location and then
provides you the ability to send it to an external recipient via either
e-mail or Bluetooth. Some options may be greyed-out.

 Save cursor position: Stores the current location as: a contact
entry, Favorite Location, as your home address, or as your office
address.

o Search for Points-of-interest: displays points of interest near both
your current location and along a selected travel route.

o Add to route: opens the Plan new route view where you select a
new route for your current trip.

Touch Back icon ( 4 ) to exit from the current menu.
Touch the Main menu icon (-') to reveal options that
are available during either navigation or map browsing.
Options included in the Main menu are:

o Search: select from an available online database of information and
then search based on one of the following parameters: Locations,
Favorites, History, Points-of-Interest, Contacts (with their associated
locations), and a location based on a specific Latitude/Longitude.

 Navigate: navigate based on an available online database of
information and then navigate based on one of the following
parameters: Locations, Favorites, History, Points-of-Interest,
Contacts (with their associated locations), and a location based on a
specific Latitude/Longitude.

* Travel mode: create a custom navigation based on driving either
the fastest route, shortest route, or walking. Touch to green select
icon to store this new selection.

o Extras: use one of the additional Route66 services, such as: Maps,
Traffic information, Safety cameras, Weather updates, Voices (to
change the current readout language and gender), Colour schemes
(to change the current Route66 color scheme), Travel guides,
Update (update the Route 66 software version), and Enter voucher
code (update or add a new Voucher code).

o Zoom: alter the current map zoom magnification.

o View: select different visualization options such as: Day/Night
colours, 2D/3D perspectives, Navigation screen layout, GPS
information, GPS stats, Volume levels, and information About Route
66.

o Send: send one of the following to an extermnal recipient: current
Map as image, GPS position, current selected Cursor position, or a
route description.

 Save: stores (within either the application itself or within the
microSD card) a current Map location as an image, GPS location, or
a selected Cursor position.

 Routes: select a different route.



o Settings: customize the Route66 application settings such as:
General, Map, Navigation, Speed, Alarm, Extras, Legend, Screen
orientation, Date & Time, or calibrate screen.

e Photos: access locally stored images.
e Help: provides onscreen help information about Route66.
o Exit: exits the Route66 application.

For additional usage information, visit http://www.66.com/support/,
and select User Manuals.
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Section 8: Health and Safety Information

This section outlines the safety precautions associated with using
your device. These safety precautions should be followed to
safely use your device.

Health and Safety Information
Warning Regarding Display

The display on your handset is made of glass or acrylic and could
breakifyour handsetis dropped or if it receives significantimpact. Do

notuse if screen is broken or cracked as this could cause injury toyou.

Samsung Mobile Products and Recycling

Samsung cares for the environment and encourages its
customers to recycle Samsung mobile devices and genuine
Samsung accessories.

Go to: https:/fun.samsungmobileusa.com/recycling/index.jsp for more
information.

UL Certified Travel Adapter
The Travel Adapter for this device has met applicable UL safety

requirements. Please adhere to the following safety instructions
per UL guidelines.
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FAILURE TO FOLLOW THE INSTRUCTIONS OUTLINED MAY LEAD
TO SERIOUS PERSONAL INJURY AND POSSIBLE PROPERTY
DAMAGE.

IMPORTANT SAFETY INSTRUCTIONS - SAVE THESE
INSTRUCTIONS.

DANGER - TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK,
CAREFULLY FOLLOW THESE INSTRUCTIONS.

FOR CONNECTION TO A SUPPLY NOT IN NORTH AMERICA, USE
AN ATTACHMENT PLUG ADAPTOR OF THE PROPER
CONFIGURATION FOR THE POWER OUTLET. THIS POWER UNIT IS
INTENDED TO BE CORRECTLY ORIENTATED IN A VERTICAL OR
HORIZONTAL OR FLOOR MOUNT POSITION.

Consumer Information on Wireless Devices
The U.S. Food and Drug Administration (FDA) has published a
series of Questions and Answers for consumers relating to radio

frequency (RF) exposure from wireless devices. The FDA
publication includes the following information:

What kinds of devices are the subject of this update?

The term wireless device refers here to hand-held wireless
devices with built-in antennas, often called "cell," "mobile," or
"PCS" devices. These types of wireless devices can expose the


https://fun.samsungmobileusa.com/recycling/index.jsp

user to measurable radio frequency energy (RF) because of the
short distance between the device and the user's head. These RF
exposures are limited by Federal Communications Commission
safety guidelines that were developed with the advice of FDA and
other federal health and safety agencies.

When the device is located at greater distances from the user,
the exposure to RF is drastically lower because a person's RF
exposure decreases rapidly with increasing distance from the
source. The so-called "cordless devices," which have a base unit
connected to the telephone wiring in a house, typically operate at
far lower power levels, and thus produce RF exposures well
within the FCC's compliance limits.

Do wireless devices pose a health hazard?

The available scientific evidence does not show that any health
problems are associated with using wireless devices. There is no
proof, however, that wireless devices are absolutely safe.
Wireless devices emit low levels of radio frequency energy (RF) in
the microwave range while being used. They also emit very low
levels of RF when in the stand-by mode. Whereas high levels of
RF can produce health effects (by heating tissue), exposure to
low level RF that does not produce heating effects causes no
known adverse health effects. Many studies of low level RF
exposures have not found any biological effects. Some studies

have suggested that some biological effects may occur, but such
findings have not been confirmed by additional research.

In some cases, other researchers have had difficulty in
reproducing those studies, or in determining the reasons for
inconsistent results.

What is FDA's role concerning the safety of wireless
devices?

Under the law, FDA does not review the safety of radiation-
emitting consumer products such as wireless devices before they
can be sold, as it does with new drugs or medical devices.
However, the agency has authority to take action if wireless
devices are shown to emit radio frequency energy (RF) at a level
that is hazardous to the user. In such a case, FDA could require
the manufacturers of wireless devices to notify users of the
health hazard and to repair, replace or recall the devices so that
the hazard no longer exists.
Although the existing scientific data do not justify FDA regulatory
actions, FDA has urged the wireless device industry to take a
number of steps, including the following:
 Support needed research into possible biological effects of RF of the
type emitted by wireless devices;
o Design wireless devices in a way that minimizes any RF exposure to
the user that is not necessary for device function; and
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 Cooperate in providing users of wireless devices with the best possible
information on possible effects of wireless device use on human
health.

FDA belongs to an interagency working group of the federal
agencies that have responsibility for different aspects of RF
safety to ensure coordinated efforts at the federal level. The
following agencies belong to this working group:

 National Institute for Occupational Safety and Health
 Environmental Protection Agency

o Federal Communications Commission

 Occupational Safety and Health Administration

o National Telecommunications and Information Administration

The National Institutes of Health participates in some interagency
working group activities, as well.

FDA shares regulatory responsibilities for wireless devices with
the Federal Communications Commission (FCC). All devices that
are sold in the United States must comply with FCC safety
guidelines that limit RF exposure. FCC relies on FDA and other
health agencies for safety questions about wireless devices.

FCC also regulates the base stations that the wireless device
networks rely upon. While these base stations operate at higher
power than do the wireless devices themselves, the RF
exposures that people get from these base stations are typically
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thousands of times lower than those they can get from wireless
devices.

Base stations are thus not the primary subject of the safety
questions discussed in this document.

What are the results of the research done already?

The research done thus far has produced conflicting results, and
many studies have suffered from flaws in their research
methods. Animal experiments investigating the effects of radio
frequency energy (RF) exposures characteristic of wireless
devices have yielded conflicting results that often cannot be
repeated in other laboratories. A few animal studies, however,
have suggested that low levels of RF could accelerate the
development of cancer in laboratory animals.

However, many of the studies that showed increased tumor
development used animals that had been genetically engineered
or treated with cancer-causing chemicals so as to be pre-
disposed to develop cancer in absence of RF exposure. Other
studies exposed the animals to RF for up to 22 hours per day.
These conditions are not similar to the conditions under which
people use wireless devices, so we don't know with certainty
what the results of such studies mean for human health.

Three large epidemiology studies have been published since
December 2000. Between them, the studies investigated any
possible association between the use of wireless devices and



primary brain cancer, glioma, meningioma, or acoustic neuroma,
tumors of the brain or salivary gland, leukemia, or other cancers.

None of the studies demonstrated the existence of any harmful
health effects from wireless devices RF exposures. However,
none of the studies can answer questions about long-term
exposures, since the average period of device use in these
studies was around three years.

What research is needed to decide whether RF exposure
from wireless devices poses a health risk?

A combination of laboratory studies and epidemiological studies
of people actually using wireless devices would provide some of
the data that are needed. Lifetime animal exposure studies could
be completed in a few years. However, very large numbers of
animals would be needed to provide reliable proof of a cancer
promoting effect if one exists. Epidemiological studies can
provide data that is directly applicable to human populations, but
ten or more years' follow-up may be needed to provide answers
about some health effects, such as cancer. This is because the
interval between the time of exposure to a cancer-causing agent
and the time tumors develop - if they do - may be many, many
years. The interpretation of epidemiological studies is hampered
by difficulties in measuring actual RF exposure during day-to-day
use of wireless devices.

Many factors affect this measurement, such as the angle at
which the device is held, or which model of device is used.

What is FDA doing to find out more about the possible
health effects of wireless device RF?

FDA is working with the U.S. National Toxicology Program and
with groups of investigators around the world to ensure that high
priority animal studies are conducted to address important
questions about the effects of exposure to radio frequency
energy (RF). FDA has been a leading participant in the World
Health Organization international Electromagnetic Fields (EMF)
Project since its inception in 1996. An influential result of this
work has been the development of a detailed agenda of research
needs that has driven the establishment of new research
programs around the world. The Project has also helped develop
a series of public information documents on EMF issues.

FDA and Cellular Telecommunications & Internet Association
(CTIA) have a formal Cooperative Research and Development
Agreement (CRADA) to do research on wireless device safety.
FDA provides the scientific oversight, obtaining input from
experts in government, industry, and academic organizations.

CTIA-funded research is conducted through contracts to
independent investigators. The initial research will include both
laboratory studies and studies of wireless device users. The
CRADA will also include a broad assessment of additional

Health and Safety Information 98



research needs in the context of the latest research
developments around the world.

What steps can I take to reduce my exposure to radio
frequency energy from my wireless device?

If there is a risk from these products - and at this point we do not
know that there is - it is probably very small. But if you are
concerned about avoiding even potential risks, you can take a
few simple steps to minimize your exposure to radio frequency
energy (RF). Since time is a key factor in how much exposure a
person receives, reducing the amount of time spent using a
wireless device will reduce RF exposure.

« If you must conduct extended conversations by wireless device every
day, you could place more distance between your body and the source
of the RF, since the exposure level drops off dramatically with distance.
For example, you could use a headset and carry the wireless device
away from your body or use a wireless device connected to a remote
antenna.

Again, the scientific data do not demonstrate that wireless
devices are harmful. But if you are concerned about the RF
exposure from these products, you can use measures like those
described above to reduce your RF exposure from wireless
device use.
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What about children using wireless devices?

The scientific evidence does not show a danger to users of
wireless devices, including children and teenagers. If you want to
take steps to lower exposure to radio frequency energy (RF), the
measures described above would apply to children and
teenagers using wireless devices. Reducing the time of wireless
device use and increasing the distance between the user and the
RF source will reduce RF exposure.

Some groups sponsored by other national governments have
advised that children be discouraged from using wireless devices
at all. For example, the government in the United Kingdom
distributed leaflets containing such a recommendation in
December 2000. They noted that no evidence exists that using a
wireless device causes brain tumors or other ill effects.

Their recommendation to limit wireless device use by children
was strictly precautionary; it was not based on scientific
evidence that any health hazard exists.

Do hands-free kits for wireless devices reduce
risks from exposure to RF emissions?

Since there are no known risks from exposure to RF emissions
from wireless devices, there is no reason to believe that hands-
free kits reduce risks. Hands-free kits can be used with wireless
devices for convenience and comfort. These systems reduce the
absorption of RF energy in the head because the device, which is



the source of the RF emissions, will not be placed against the
head. On the other hand, if the device is mounted against the
waist or other part of the body during use, then that part of the
body will absorb more RF energy.

Wireless devices marketed in the U.S. are required to meet safety
requirements regardless of whether they are used against the
head or against the body. Either configuration should result in
compliance with the safety limit.

Do wireless device accessories that claim to shield
the head from RF radiation work?

Since there are no known risks from exposure to RF emissions
from wireless devices, there is no reason to believe that
accessories that claim to shield the head from those emissions
reduce risks. Some products that claim to shield the user from RF
absorption use special device cases, while others involve nothing
more than a metallic accessory attached to the device. Studies
have shown that these products generally do not work as
advertised. Unlike "hand-free" kits, these so-called "shields"
may interfere with proper operation of the device. The device
may be forced to boost its power to compensate, leading to an
increase in RF absorption. In February 2002, the Federal trade
Commission (FTC) charged two companies that sold devices that
claimed to protect wireless device users from radiation with
making false and unsubstantiated claims.

According to FTC, these defendants lacked a reasonable basis to
substantiate their claim.

What about wireless device interference with
medical equipment?

Radio frequency energy (RF) from wireless devices can interact
with some electronic devices. For this reason, FDA helped
develop a detailed test method to measure electromagnetic
interference (EMI) of implanted cardiac pacemakers and
defibrillators from wireless devices. This test method is now part
of a standard sponsored by the Association for the Advancement
of Medical instrumentation (AAMI). The final draft, a joint effort by
FDA, medical device manufacturers, and many other groups, was
completed in late 2000. This standard will allow manufacturers
to ensure that cardiac pacemakers and defibrillators are safe
from wireless device EMI. FDA has tested wireless devices and
helped develop a voluntary standard sponsored by the Institute of
Electrical and Electronic Engineers (IEEE). This standard specifies
test methods and performance requirements for hearing aids and
wireless devices so that no interference occurs when a person
uses a compatible device and a compatible hearing aid at the
same time. This standard was approved by the IEEE in 2000.

FDA continues to monitor the use of wireless devices for possible
interactions with other medical devices. Should harmful
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interference be found to occur, FDA will conduct testing to assess

the interference and work to resolve the problem.

Additional information on the safety of RF exposures from various

sources can be obtained from the following organizations

(Updated 12/1/2006):

 FCC RF Safety Program:
http://www.fcc.gov/oet/rfsafety/

 Environmental Protection Agency (EPA):
http://www.epa.gov/radiation/

 Occupational Safety and Health Administration's (OSHA):
http://www.osha.gov/SLTC/radiofrequencyradiation/index.html

o National Institute for Occupational Safety and Health (NIOSH):
http://www.cdc.gov/niosh/homepage.html

 World Health Organization (WHO):
http://www.who.int/peh-emf/

o International Commission on Non-lonizing Radiation Protection:

http://www.icnirp.de

 Health Protection Agency:
http://www.hpa.org.uk/radiation

o US Food and Drug Administration:
http://www.fda.gov/cellphones
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Road Safety

If you have downloaded VolP software to your device in order to
use it as a phone, you should exercise caution in driving while
using that feature.

When driving a car, driving is your first responsibility. When using
your wireless device behind the wheel of a car, practice good
common sense and remember the following tips:

1.

Get to know your wireless device and its features, such as
speed dial and redial. If available, these features help you
to place your call without taking your attention off the road.

When available, use a hands-free device. If possible, add
an additional layer of convenience and safety to your
wireless device with one of the many hands free
accessories available today.

Position your wireless device within easy reach. Be able to
access your wireless device without removing your eyes
from the road. If you get an incoming call at an
inconvenient time, let your voice mail answer it for you.


http://www.fcc.gov/oet/rfsafety/
http://www.epa.gov/radiation/
http://www.osha.gov/SLTC/radiofrequencyradiation/index.html
http://www.cdc.gov/niosh/homepage.html
http://www.hpa.org.uk/radiation
http://www.icnirp.de
http://www.hpa.org.uk/radiation
http://www.fda.gov/cellphones

Let the person you are speaking with know you are driving;
if necessary, suspend the call in heavy traffic or hazardous
weather conditions. Rain, sleet, snow, ice and even heavy
traffic can be hazardous.

Do not take notes or look up device numbers while driving.
Jotting down a "to do" list or flipping through your address
book takes attention away from your primary
responsibility, driving safely.

Dial sensibly and assess the traffic; if possible, place calls
when you are not moving or before pulling into traffic. Try
to plan calls when your car will be stationary. If you need to
make a call while moving, dial only a few numbers, check
the road and your mirrors, then continue.

Do not engage in stressful or emotional conversations that
may be distracting. Make people you are talking with
aware you are driving and suspend conversations that
have the potential to divert your attention from the road.

8. Do not use your device to make any emergency or
emergency service calls ( e.g. 211, 911, 999, etc.). To
make calls of this type you must use a landline or a
cell/mobile phone.
"The wireless industry reminds you to use your device safely when
driving."

For more information, please call 1-888-901-SAFE, or visit our
web-site www.ctia.org.

Important!: If you are using a handset other than a standard numeric keypad,
please call 1-888-901-7233.

Provided by the Cellular Telecommunications & Internet
Association.

Responsible Listening

Caution!: Avoid potential hearing loss.

Damage to hearing occurs when a person is exposed to loud
sounds over time. The risk of hearing loss increases as sound is
played louder and for longer durations. Prolonged exposure to
loud sounds (including music) is the most common cause of
preventable hearing loss. Some scientific research suggests that
using portable audio devices, such as portable music players and

Health and Safety Information 102


http://www.ctia.org/

cellular devices, at high volume settings for long durations may
lead to permanent noise-induced hearing loss. This includes the
use of headphones (including headsets, earbuds, and Bluetooth
or other wireless devices).

Exposure to very loud sound has also been associated in some
studies with tinnitus (a ringing in the ear), hypersensitivity to
sound and distorted hearing.

Individual susceptibility to noise-induced hearing loss and
potential hearing problem varies. Additionally, the amount of
sound produced by a portable audio device varies depending on
the nature of the sound, the device settings, and the headphones
that are used. As a result, there is no single volume setting that is
appropriate for everyone or for every combination of sound,
settings and equipment.

You should follow some commonsense recommendations when

using any portable audio device:

 Set the volume in a quiet environment and select the lowest volume at
which you can hear adequately.

 When using headphones, turn the volume down if you cannot hear the
people speaking near you or if the person sitting next to you can hear
what you are listening to.

Do not turn the volume up to block out noisy surroundings. If you
choose to listen to your portable device in a noisy environment, use
noise-cancelling headphones to block out background environmental
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noise. By blocking background environment noise, noise cancelling
headphones should allow you to hear the music at lower volumes than
when using earbuds.

 Limit the amount of time you listen. As the volume increases, less time
is required before you hearing could be affected.

 Avoid using headphones after exposure to extremely loud noises, such
as rock concerts, that might cause temporary hearing loss. Temporary
hearing loss might cause unsafe volumes to sound normal.

Do not listen at any volume that causes you discomfort. If you
experience ringing in your ears, hear muffled speech or experience
any temporary hearing difficulty after listening to your portable audio
device, discontinue use and consult your doctor.

You can obtain additional information on this subject from the

following sources:

American Academy of Audiology

11730 Plaza American Drive, Suite 300
Reston, VA 20190

Voice: (800) 222-2336

Email: info@audiology.org

Internet: http://www.audiology.org


http://www.audiology.org

National Institute on Deafness and Other Communication Disorders
National Institutes of Health

31 Center Drive, MSC 2320

Bethesda, MD 20892-2320

Email: nidcdinfo@nih.gov

Internet: http://www.nidcd.nih.gov/

National Institute for Occupational Safety and Health (NIOSH)
395 E Street, S.W.

Suite 9200

Patriots Plaza Building

Washington, DC 20201

Voice: 1-800-35-NIOSH (1-800-356-4647)
1-800-CDC-INFO (1-800-232-4636)

Outside the U.S. 513-533-8328

Email: cdcinfo@cdc.gov

Internet: http://www.cdc.gov

1-888-232-6348 TTY

Internet: http://www.cdc.gov/niosh/topics/noise/default.html

Operating Environment

Remember to follow any special regulations in force in any area
and always switch your device off whenever it is forbidden to use
it, or when it may cause interference or danger. When connecting
the device or any accessory to another device, read its user's
guide for detailed safety instructions. Do not connect
incompatible products.

As with other mobile radio transmitting equipment, users are
advised that for the satisfactory operation of the equipment and
for the safety of personnel, it is recommended that the
equipment should only be used in the normal operating position
(held to your ear with the antenna pointing over your shoulder if
you are using an external antenna).
Using Your Device Near Other Electronic
Devices
Most modern electronic equipment is shielded from radio
frequency (RF) signals. However, certain electronic equipment

may not be shielded against the RF signals from your wireless
device. Consult the manufacturer to discuss alternatives.
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Implantable Medical Devices

A minimum separation of six (6) inches should be maintained
between a handheld wireless device and an implantable medical
device, such as a pacemaker or implantable cardioverter
defibrillator, to avoid potential interference with the device.
Persons who have such devices:

 Should ALWAYS keep the device more than six (6) inches from their
implantable medical device when the device is turned ON;

 Should not carry the device in a breast pocket;

 Should use the ear opposite the implantable medical device to
minimize the potential for interference;

 Should turn the device OFF immediately if there is any reason to
suspect that interference is taking place.

o Should read and follow the directions from the manufacturer of your
implantable medical device. if you have any questions about using
your wireless device with such a device, consult your health care
provider.

For more information see:
http://www.fcc.gov/oet/rfsafety/rf-fags.html
Hearing Aid Compatibility with Mobile Devices

Some digital wireless devices may interfere with some hearing
aids. In the event of such interference, you may wish to consult
your hearing aid manufacturer to discuss alternatives.

105

HACIWi-Fi Language

This phone has been tested and rated for use with hearing aids
for some of the wireless technologies that it uses. However, there
may be some newer wireless technologies used in this phone
that have not been tested yet for use with hearing aids. It is
important to try the different features of this phone thoroughly
and in different locations, using your hearing aid or cochlear
implant, to determine if you hear any interfering noise. Consult
your service provider about its return and exchange policies and
for information on hearing aid compatibility.

Other Medical Devices

If you use any other personal medical devices, consult the
manufacturer of your device to determine if it is adequately
shielded from external RF energy. Your physician may be able to
assist you in obtaining this information. Switch your device off in
health care facilities when any regulations posted in these areas
instruct you to do so. Hospitals or health care facilities may be
using equipment that could be sensitive to external RF energy.

Vehicles

RF signals may affect improperly installed or inadequately
shielded electronic systems in motor vehicles. Check with the
manufacturer or its representative regarding your vehicle. You
should also consult the manufacturer of any equipment that has
been added to your vehicle.


http://www.fcc.gov/oet/rfsafety/rf-faqs.html

 



Posted Facilities

Switch your device off in any facility where posted notices
require you to do so.

Potentially Explosive Environments

Switch your device off when in any area with a potentially
explosive atmosphere and obey all signs and instructions. Sparks
in such areas could cause an explosion or fire resulting in bodily
injury or even death.

Users are advised to switch the device off while at a refueling
point (service station). Users are reminded of the need to observe
restrictions on the use of radio equipment in fuel depots (fuel
storage and distribution areas), chemical plants or where blasting
operations are in progress.

Areas with a potentially explosive atmosphere are often but not
always clearly marked. They include below deck on boats,
chemical transfer or storage facilities, vehicles using liquefied
petroleum gas (such as propane or butane), areas where the air
contains chemicals or particles, such as grain, dust or metal
powders, and any other area where you would normally be
advised to turn off your vehicle engine.

Restricting Children's access to your Device

Your device is not a toy. Children should not be allowed to play
with it because they could hurt themselves and others, damage
the device or make calls that increase your device bill.

FCC Notice and Cautions
FCC Notice

The device may cause TV or radio interference if used in close
proximity to receiving equipment. The FCC can require you to
stop using the device if such interference cannot be eliminated.

Vehicles using liquefied petroleum gas (such as propane or
butane) must comply with the National Fire Protection Standard
(NFPA-58). For a copy of this standard, contact the National Fire
Protection Association:

NFPA (National Fire Protection Agency)
1 Batterymarch Park

Quincy, Massachusetts

USA 02169-7471

Internet: http://www.nfpa.org
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Cautions

Any changes or modifications to your device not expressly
approved in this document could void your warranty for this
equipment, and void your authority to operate this equipment.
Only use approved batteries, antennas and chargers. The use of
any unauthorized accessories may be dangerous and void the
device warranty if said accessories cause damage or a defect to
the device.

Although your device is quite sturdy, it is a complex piece of
equipment and can be broken. Avoid dropping, hitting, bending
or sitting on it.

Other Important Safety Information

* Only qualified personnel should service the device or install the device
in a vehicle. Faulty installation or service may be dangerous and may
invalidate any warranty applicable to the device.

o Check regularly that all wireless device equipment in your vehicle is
mounted and operating properly.

Do not store or carry flammable liquids, gases or explosive materials in
the same compartment as the device, its parts or accessories.

« For vehicles equipped with an air bag, remember that an air bag
inflates with great force. Do not place objects, including both installed
or portable wireless equipment in the area over the air bag or in the air
bag deployment area. If wireless equipment is improperly installed and
the air bag inflates, serious injury could result.
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 Switch your device off before boarding an aircraft. The use of wireless
device in aircraft is illegal and may be dangerous to the aircraft's
operation.

o Failure to observe these instructions may lead to the suspension or
denial of telephone services to the offender, or legal action, or both.

Product Performance
Understanding the Power Save Feature

If your device is unable to find a signal after searching, a Power
Save feature is automatically activated. If your device is active, it
periodically rechecks service availability or you can check it
yourself by pressing any key.

Anytime the Power Save feature is activated, a message displays
on the screen. When a signal is found, your device returns to
standby mode.

Maintaining Your Device's Peak Performance

For the best care of your device, only authorized personnel
should service your device and accessories. Faulty service may
void the warranty.

There are several simple guidelines to operating your device

properly and maintaining safe, satisfactory service.

o If your device is equipped with an external antenna, hold the device
with the antenna raised, fully-extended and over your shoulder.

* Do not hold, bend or twist the device's antenna, if applicable.



* Do not use the device if the antenna is damaged.

o If your device is equipped with an internal antenna, obstructing the
internal antenna could inhibit call performance.

 Speak directly into the device's receiver.

« Avoid exposing your device and accessories to rain or liquid spills. If
your device does get wet, immediately turn the power off and remove
the battery. If it is inoperable, call Customer Care for service.

Availability of Various Features/Ring Tones

Many services and features are network dependent and may
require additional subscription and/or usage charges. Not all
features are available for purchase or use in all areas.
Downloadable Ring Tones may be available at an additional cost.
Other conditions and restrictions may apply. See your service
provider for additional information.

WiMAX Language

This device is expected to achieve speeds that are twice that of
3G wireless service. Overall internet experience will vary
depending on a number of factors including device parameters,
patterns of usage, network conditions and the characteristics of
websites visited.

Battery Standby and Talk Time

Standby and talk times will vary depending on device usage

patterns and conditions. Battery power consumption depends on

factors such as network configuration, signal strength, operating
temperature, features selected, frequency of calls, and voice,
data, and other application usage patterns.

Battery Precautions

o Avoid dropping the cell device. Dropping it, especially on a hard
surface, can potentially cause damage to the device and battery. If you
suspect damage to the device or battery, take it to a service center for
inspection.

 Never use any charger or battery that is damaged in any way.

Do not modify or remanufacture the battery as this could result in
serious safety hazards.

o If you use the device near the network's base station, it uses less
power; talk and standby time are greatly affected by the signal
strength on the cellular network and the parameters set by the
network operator.

o Follow battery usage, storage and charging guidelines found in the
user’s guide.
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o Battery charging time depends on the remaining battery charge and
the type of battery and charger used. The battery can be charged and
discharged hundreds of times, but it will gradually wear out. When the
operation time (talk time and standby time) is noticeably shorter than
normal, it is time to buy a new battery.

o If left unused, a fully charged battery will discharge itself over time.

 Use only Samsung-approved batteries and recharge your battery only
with Samsung-approved chargers. When a charger is not in use,
disconnect it from the power source. Do not leave the battery
connected to a charger for more than a week, since overcharging may
shorten its life.

Do not use incompatible cell device batteries and chargers. Some Web
sites and second-hand dealers, not associated with reputable
manufacturers and carriers, might be selling incompatible or even
counterfeit batteries and chargers. Consumers should purchase
manufacturer or carrier recommended products and accessories. If
unsure about whether a replacement battery or charger is compatible,
contact the manufacturer of the battery or charger.

* Misuse or use of incompatible devices, batteries, and charging devices
could result in damage to the equipment and a possible risk of fire,
explosion, leakage, or other serious hazard.

 Extreme temperatures will affect the charging capacity of your battery:
it may require cooling or warming first.
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* Do not leave the battery in hot or cold places, such as in a car in
summer or winter conditions, as you will reduce the capacity and
lifetime of the battery. Always try to keep the battery at room
temperature. A device with a hot or cold battery may temporarily not
work, even when the battery is fully charged. Li-ion batteries are
particularly affected by temperatures below 0 °C (32 °F).

* Do not place the device in areas that may get very hot, such as on or
near a cooking surface, cooking appliance, iron, or radiator.

Do not get your device or battery wet. Even though they will dry and
appear to operate normally, the circuitry could slowly corrode and
pose a safety hazard.

Do not short-circuit the battery. Accidental short-circuiting can occur
when a metallic object (coin, clip or pen) causes a direct connection
between the + and - terminals of the battery (metal strips on the
battery), for example when you carry a spare battery in a pocket or
bag. Short-circuiting the terminals may damage the battery or the
object causing the short-circuiting.

Do not permit a battery out of the device to come in contact with metal
objects, such as coins, keys or jewelry.

Do not crush, puncture or put a high degree of pressure on the battery
as this can cause an internal short-circuit, resulting in overheating.



o Dispose of used batteries in accordance with local regulations. In some
areas, the disposal of batteries in household or business trash may be
prohibited. For safe disposal options for Li-lon batteries, contact your
nearest Samsung authorized service center. Always recycle. Do not
dispose of batteries in a fire.

Window Mounted Accessory Precautions
NOTICE TO DRIVERS IN CALIFORNIA AND MINNESOTA

State law prohibits drivers in Minnesota from using suction
mounts on their windshields while operating motor vehicles.
California state law permits GPS systems to be mounted in a
7-inch square in the lower corner of the windshield farthest
removed from the driver or in a 5-inch square in the lower corner
of the windshield nearest to the driver, if the system is used only
for door-to-door navigation while the motor vehicle is being
operated and outside of an airbag deployment zone. Other state
or local laws may also prohibit drivers from using suction cups on
their windshields or operating the GPS system while the car is in
motion. Other dashboard or friction mounting options should be
used, but only if the driver's view is not obstructed. We do not
take any responsibility for any fines, penalties, or damages that
may be incurred as a result of disregarding this notice. (See
California Vehicle Code Section 26708(a); Minnesota Statutes
2005, Section 169.71)

Care and Maintenance

Your device is a product of superior design and craftsmanship
and should be treated with care. The suggestions below will help
you fulfill any warranty obligations and allow you to enjoy this
product for many years.

o Keep the device and all its parts and accessories out of the reach of
small children.

o Keep the device dry. Precipitation, humidity and liquids contain
minerals that will corrode electronic circuits.

Do not use the device with a wet hand. Doing so may cause an electric
shock to you or damage to the device.

e Do not use or store the device in dusty, dirty areas, as its moving parts
may be damaged.

* Do not store the device in hot areas. High temperatures can shorten
the life of electronic devices, damage batteries, and warp or melt
certain plastics.

Do not store the device in cold areas. When the device warms up to its
normal operating temperature, moisture can form inside the device,
which may damage the device's electronic circuit boards.

Do not drop, knock or shake the device. Rough handling can break
internal circuit boards.

Do not use harsh chemicals, cleaning solvents or strong detergents to
clean the device. Wipe it with a soft cloth slightly dampened in a mild
soap-and-water solution.
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Do not paint the device. Paint can clog the device's moving parts and
prevent proper operation.

Do not put the device in or on heating devices, such as a microwave
oven, a stove or a radiator. The device may explode when overheated.

o If your device is equipped with an external antenna, use only the
supplied or an approved replacement antenna. Unauthorized antennas
or modified accessories may damage the device and violate
regulations governing radio devices.

o [f the device, battery, charger or any accessory is not working properly,
take it to your nearest qualified service facility. The personnel there
will assist you, and if necessary, arrange for service.
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Section 9: Warranty Information

Standard Limited Warranty

What is Covered and For How Long?

SAMSUNG TELECOMMUNICATIONS AMERICA, LLC ("SAMSUNG")
warrants to the original purchaser ("Purchaser") that SAMSUNG's
Phones and accessories ("Products") are free from defects in
material and workmanship under normal use and service for the
period commencing upon the date of purchase and continuing for
the following specified period of time after that date:

Device 1 Year

Batteries 1 Year

What is Not Covered? This Limited Warranty is conditioned upon
proper use of Product by Purchaser. This Limited Warranty does
not cover: (a) defects or damage resulting from accident, misuse,
abuse, neglect, unusual physical, electrical or electromechanical
stress, or modification of any part of Product, including antenna,
or cosmetic damage; (b) equipment that has the serial number
removed or made illegible; (c) any plastic surfaces or other
externally exposed parts that are scratched or damaged due to
normal use; (d) malfunctions resulting from the use of Product in
conjunction with accessories, products, or ancillary/peripheral

equipment not furnished or approved by SAMSUNG; (e) defects or
damage from improper testing, operation, maintenance,
installation, or adjustment; (f) installation, maintenance, and
service of Product, or (g) Product used or purchased outside the
United States or Canada.

This Limited Warranty covers batteries only if battery capacity
falls below 80% of rated capacity or the battery leaks, and this
Limited Warranty does not cover any battery if (i) the battery has
been charged by a battery charger not specified or approved by
SAMSUNG for charging the battery, (ii) any of the seals on the
battery are broken or show evidence of tampering, or (iii) the
battery has been used in equipment other than the SAMSUNG
phone for which it is specified.

What are SAMSUNG's Obligations? During the applicable warranty
period, SAMSUNG will repair or replace, at SAMSUNG's sole
option, without charge to Purchaser, any defective component
part of Product. To obtain service under this Limited Warranty,
Purchaser must return Product to an authorized phone service
facility in an adequate container for shipping, accompanied by
Purchaser's sales receipt or comparable substitute proof of sale
showing the date of purchase, the serial number of Product and
the sellers' name and address. To obtain assistance on where to
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deliver the Product, call Samsung Customer Care at 1-888-987-
4357. Upon receipt, SAMSUNG will promptly repair or replace the
defective Product. SAMSUNG may, at SAMSUNG's sole option,
use rebuilt, reconditioned, or new parts or components when
repairing any Product or replace Product with a rebuilt,
reconditioned or new Product. Repaired/replaced leather cases,
pouches and holsters will be warranted for a period of ninety (90)
days. All other repaired/replaced Product will be warranted for a
period equal to the remainder of the original Limited Warranty on
the original Product or for 90 days, whichever is longer. All
replaced parts, components, boards and equipment shall
become the property of SAMSUNG.

If SAMSUNG determines that any Product is not covered by this
Limited Warranty, Purchaser must pay all parts, shipping, and
labor charges for the repair or return of such Product.

WHAT ARE THE LIMITS ON SAMSUNG'S WARRANTY/LIABILITY?
EXCEPT AS SET FORTH IN THE EXPRESS WARRANTY CONTAINED
HEREIN, PURCHASER TAKES THE PRODUCT "AS IS," AND
SAMSUNG MAKES NO WARRANTY OR REPRESENTATION AND
THERE ARE NO CONDITIONS, EXPRESS OR IMPLIED, STATUTORY
OR OTHERWISE, OF ANY KIND WHATSOEVER WITH RESPECT TO
THE PRODUCT, INCLUDING BUT NOT LIMITED TO:
© THE MERCHANTABILITY OF THE PRODUCT OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE OR USE;
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o WARRANTIES OF TITLE OR NON-INFRINGEMENT;

 DESIGN, CONDITION, QUALITY, OR PERFORMANCE OF THE PRODUCT;

 THE WORKMANSHIP OF THE PRODUCT OR THE COMPONENTS
CONTAINED THEREIN; OR

* COMPLIANCE OF THE PRODUCT WITH THE REQUIREMENTS OF ANY
LAW, RULE, SPECIFICATION OR CONTRACT PERTAINING THERETO.

NOTHING CONTAINED IN THE INSTRUCTION MANUAL SHALL BE
CONSTRUED TO CREATE AN EXPRESS WARRANTY OF ANY KIND
WHATSOEVER WITH RESPECT TO THE PRODUCT. ALL IMPLIED
WARRANTIES AND CONDITIONS THAT MAY ARISE BY OPERATION
OF LAW, INCLUDING IF APPLICABLE THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, ARE HEREBY LIMITED TO THE SAME DURATION OF
TIME AS THE EXPRESS WRITTEN WARRANTY STATED HEREIN.
SOME STATES/PROVINCES DO NOT ALLOW LIMITATIONS ON HOW
LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION
MAY NOT APPLY TO YOU. IN ADDITION, SAMSUNG SHALL NOT BE
LIABLE FOR ANY DAMAGES OF ANY KIND RESULTING FROM THE
PURCHASE, USE, OR MISUSE OF, OR INABILITY TO USE THE
PRODUCT OR ARISING DIRECTLY OR INDIRECTLY FROM THE USE
OR LOSS OF USE OF THE PRODUCT OR FROM THE BREACH OF
THE EXPRESS WARRANTY, INCLUDING INCIDENTAL, SPECIAL,
CONSEQUENTIAL OR SIMILAR DAMAGES, OR LOSS OF
ANTICIPATED PROFITS OR BENEFITS, OR FOR DAMAGES ARISING
FROM ANY TORT (INCLUDING NEGLIGENCE OR GROSS



NEGLIGENCE) OR FAULT COMMITTED BY SAMSUNG, ITS AGENTS
OR EMPLOYEES, OR FOR ANY BREACH OF CONTRACT OR FOR
ANY CLAIM BROUGHT AGAINST PURCHASER BY ANY OTHER
PARTY. SOME STATES/PROVINCES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT
APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS, WHICH VARY
FROM STATE TO STATE/PROVINCE TO PROVINCE. THIS LIMITED
WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE
ORIGINAL PURCHASER OF THIS PRODUCT AND STATES
PURCHASER'S EXCLUSIVE REMEDY. IF ANY PORTION OF THIS
LIMITED WARRANTY IS HELD ILLEGAL OR UNENFORCEABLE BY
REASON OF ANY LAW, SUCH PARTIAL ILLEGALITY OR
UNENFORCEABILITY SHALL NOT AFFECT THE ENFORCEABILITY
FOR THE REMAINDER OF THIS LIMITED WARRANTY WHICH
PURCHASER ACKNOWLEDGES IS AND WILL ALWAYS BE
CONSTRUED TO BE LIMITED BY ITS TERMS OR AS LIMITED AS
THE LAW PERMITS. THE PARTIES UNDERSTAND THAT THE
PURCHASER MAY USE THIRD-PARTY SOFTWARE OR EQUIPMENT
IN CONJUNCTION WITH THE PRODUCT. SAMSUNG MAKES NO
WARRANTIES OR REPRESENTATIONS AND THERE ARE NO
CONDITIONS, EXPRESS OR IMPLIED, STATUTORY OR
OTHERWISE, AS TO THE QUALITY, CAPABILITIES, OPERATIONS,
PERFORMANCE OR SUITABILITY OF ANY THIRDPARTY SOFTWARE

OR EQUIPMENT, WHETHER SUCH THIRD-PARTY SOFTWARE OR
EQUIPMENT IS INCLUDED WITH THE PRODUCT DISTRIBUTED BY
SAMSUNG OR OTHERWISE, INCLUDING THE ABILITY TO
INTEGRATE ANY SUCH SOFTWARE OR EQUIPMENT WITH THE
PRODUCT. THE QUALITY, CAPABILITIES, OPERATIONS,
PERFORMANCE AND SUITABILITY OF ANY SUCH THIRD-PARTY
SOFTWARE OR EQUIPMENT LIE SOLELY WITH THE PURCHASER
AND THE DIRECT VENDOR, OWNER OR SUPPLIER OF SUCH
THIRD-PARTY SOFTWARE OR EQUIPMENT, AS THE CASE MAY BE.

This Limited Warranty allocates risk of Product failure between
Purchaser and SAMSUNG, and SAMSUNG's Product pricing
reflects this allocation of risk and the limitations of liability
contained in this Limited Warranty. The agents, employees,
distributors, and dealers of SAMSUNG are not authorized to make
modifications to this Limited Warranty, or make additional
warranties binding on SAMSUNG. Accordingly, additional
statements such as dealer advertising or presentation, whether
oral or written, do not constitute warranties by SAMSUNG and
should not be relied upon.
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End User License Agreement for Software

IMPORTANT. READ CAREFULLY: This End User License Agreement
("EULA") is a legal agreement between you (either an individual
or a single entity) and Samsung Electronics Co., Ltd. for software
owned by Samsung Electronics Co., Ltd. and its affiliated
companies and its third party suppliers and licensors that
accompanies this EULA, which includes computer software and
may include associated media, printed materials, "online" or
electronic documentation ("Software"). BY CLICKING THE "I
ACCEPT" BUTTON (OR IF YOU BYPASS OR OTHERWISE DISABLE
THE "I ACCEPT", AND STILL INSTALL, COPY, DOWNLOAD,
ACCESS OR OTHERWISE USE THE SOFTWARE), YOU AGREE TO
BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO NOT
ACCEPT THE TERMS IN THIS EULA, YOU MUST CLICK THE
"DECLINE" BUTTON, DISCONTINUE USE OF THE SOFTWARE.

1. GRANT OF LICENSE. Samsung grants you the following rights
provided that you comply with all terms and conditions of this
EULA: You may install, use, access, display and run one copy of
the Software on the local hard disk(s) or other permanent storage
media of one computer and use the Software on a single
computer or a mobile device at a time, and you may not make
the Software available over a network where it could be used by
multiple computers at the same time. You may make one copy of
the Software in machine-readable form for backup purposes
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only; provided that the backup copy must include all copyright or
other proprietary notices contained on the original.

2. RESERVATION OF RIGHTS AND OWNERSHIP. Samsung reserves
all rights not expressly granted to you in this EULA. The Software
is protected by copyright and other intellectual property laws and
treaties. Samsung or its suppliers own the title, copyright and
other intellectual property rights in the Software. The Software is
licensed, not sold.

3. LIMITATIONS ON END USER RIGHTS. You may not reverse
engineer, decompile, disassemble, or otherwise attempt to
discover the source code or algorithms of, the Software (except
and only to the extent that such activity is expressly permitted by
applicable law notwithstanding this limitation), or modify, or
disable any features of, the Software, or create derivative works
based on the Software. You may not rent, lease, lend, sublicense
or provide commercial hosting services with the Software.

4. CONSENT TO USE OF DATA. You agree that Samsung and its
affiliates may collect and use technical information gathered as
part of the product support services related to the Software
provided to you, if any, related to the Software. Samsung may
use this information solely to improve its products or to provide
customized services or technologies to you and will not disclose
this information in a form that personally identifies you.



5. UPGRADES. This EULA applies to updates, supplements and
add-on components (if any) of the Software that Samsung may
provide to you or make available to you after the date you obtain
your initial copy of the Software, unless we provide other terms
along with such upgrade. To use Software identified as an
upgrade, you must first be licensed for the Software identified by
Samsung as eligible for the upgrade. After upgrading, you may
no longer use the Software that formed the basis for your
upgrade eligibility.

6. SOFTWARE TRANSFER. You may not transfer this EULA or the
rights to the Software granted herein to any third party unless it
is in connection with the sale of the mobile device which the
Software accompanied. In such event, the transfer must include
all of the Software (including all component parts, the media and
printed materials, any upgrades, this EULA) and you may not
retain any copies of the Software. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the
end user receiving the Software must agree to all the EULA
terms.

7. EXPORT RESTRICTIONS. You acknowledge that the Software is
subject to export restrictions of various countries. You agree to
comply with all applicable international and national laws that
apply to the Software, including the U.S. Export Administration
Regulations, as well as end user, end use, and destination
restrictions issued by U.S. and other governments.

8. TERMINATION. This EULA is effective until terminated. Your
rights under this License will terminate automatically without
notice from Samsung if you fail to comply with any of the terms
and conditions of this EULA. Upon termination of this EULA, you
shall cease all use of the Software and destroy all copies, full or
partial, of the Software.

9. DISCLAIMER OF WARRANTIES. You expressly acknowledge
and agree that use of the Software is at your sole risk and that
the entire risk as to satisfactory quality, performance, accuracy
and effort is with you. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, THE SOFTWARE IS PROVIDED "AS IS" AND
WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND
SAMSUNG AND ITS LICENSORS (COLLECTIVELY REFERRED TO AS
"SAMSUNG" FOR THE PURPOSES OF SECTIONS 9, 10 and 11)
HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH
RESPECT TO THE SOFTWARE, EITHER EXPRESS, IMPLIED OR
STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF
SATISFACTORY QUALITY OR WORKMANLIKE EFFORT, OF FITNESS
FOR A PARTICULAR PURPOSE, OF RELIABILITY OR AVAILABILITY,
OF ACCURACY, OF LACK OF VIRUSES, OF QUIET ENJOYMENT,
AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. SAMSUNG
DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR
ENJOYMENT OF THE SOFTWARE, THAT THE FUNCTIONS
CONTAINED IN THE SOFTWARE WILL MEET YOUR
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REQUIREMENTS, THAT THE OPERATION OF THE SOFTWARE WILL
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE
SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY SAMSUNG OR A SAMSUNG
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY.
SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON
APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THESE
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU.

10. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN
OTHER DAMAGES. TO THE EXTENT NOT PROHIBITED BY LAW, IN
NO EVENT SHALL SAMSUNG BE LIABLE FOR PERSONAL INJURY,
OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES WHATSOEVER, OR FOR LOSS OF PROFITS, LOSS OF
DATA, BUSINESS INTERRUPTION, OR FOR ANY PECUNIARY
DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR
USE OR INABILITY TO USE THE SOFTWARE, THE PROVISION OF
OR FAILURE TO PROVIDE SUPPORT OR OTHER SERVICES,
INFORMATION, SOFTWARE, AND RELATED CONTENT THROUGH
THE SOFTWARE OR OTHERWISE ARISING OUT OF THE USE OF
THE SOFTWARE, OR OTHERWISE UNDER OR IN CONNECTION
WITH ANY PROVISION OF THIS EULA, HOWEVER CAUSED,
REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT
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OR OTHERWISE) AND EVEN IF SAMSUNG HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO
NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL
INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO
THIS LIMITATION MAY NOT APPLY TO YOU.

11. LIMITATION OF LIABILITY. Notwithstanding any damages that
you might incur for any reason whatsoever (including, without
limitation, all damages referenced herein and all direct or general
damages in contract or anything else), the entire liability of
Samsung under any provision of this EULA and your exclusive
remedy hereunder shall be limited to the greater of the actual
damages you incur in reasonable reliance on the Software up to
the amount actually paid by you for the Software or US$5.00. The
foregoing limitations, exclusions and disclaimers (including
Sections 9, 10 and 11) shall apply to the maximum extent
permitted by applicable law, even if any remedy fails its essential
purpose.

12. U.S. GOVERNMENT END USERS. The Software is licensed
only with "restricted rights" and as "commercial items"
consisting of "commercial software" and "commercial software
documentation" with only those rights as are granted to all other
end users pursuant to the terms and conditions herein.



13. APPLICABLE LAW. This EULA is governed by the laws of
TEXAS, without regard to conflicts of laws principles. This EULA
shall not be governed by the UN Convention on Contracts for the
International Sale of Goods, the application of which is expressly
excluded. If a dispute, controversy or difference is not amicably
settled, it shall be finally resolved by arbitration in Seoul, Korea in
accordance with the Arbitration Rules of the Korean Commercial
Arbitration Board. The award of arbitration shall be final and
binding upon the parties.

14. ENTIRE AGREEMENT; SEVERABILITY. This EULA is the entire
agreement between you and Samsung relating to the Software
and supersedes all prior or contemporaneous oral or written
communications, proposals and representations with respect to
the Software or any other subject matter covered by this EULA. If
any provision of this EULA is held to be void, invalid,
unenforceable or illegal, the other provisions shall continue in full
force and effect.

Precautions for Transfer and Disposal

If data stored on this device is deleted or reformatted using the
standard methods, the data only appears to be removed on a
superficial level, and it may be possible for someone to retrieve
and reuse the data by means of special software.

To avoid unintended information leaks and other problems of this
sort, it is recommended that the device be returned to Samsung’s
Customer Care Center for an Extended File System (EFS) Clear
which will eliminate all user memory and return all settings to
default settings. Please contact the Samsung Customer Care
Center for details.

Important!: Please provide warranty information (proof of purchase) to
Samsung’s Customer Care Center in order to provide this service
at no charge. If the warranty has expired on the device, charges
may apply.

Customer Care Center:

1000 Klein Rd.

Plano, TX 75074

Toll Free Tel: 1.888.987.HELP (4357)
Samsung Telecommunications America, LLC:
1301 East Lookout Drive

Richardson, Texas 75082

Phone: 1-800-SAMSUNG (726-7864)

Important!: If you are using a handset other than a standard numeric keypad,
dial the numbers listed in brackets.
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Phone: 1-888-987-HELP (4357)

©2009 Samsung Telecommunications America. All rights
reserved. Samsung and Mondi are all trademarks of Samsung
Electronics America, Inc. and its related entities.

DivX®isa registered trademark of DivX, Inc., and is used under
license.

No reproduction in whole or in part allowed without prior written
approval. Specifications and availability subject to change
without notice.
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